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Read Me First
 
Welcome to Take Control of Troubleshooting Your Mac, Second 
Edition, published in May 2011 by TidBITS Publishing Inc. This 
book was written by Joe Kissell and edited by Adam Engst. 

Macs are easy to use, but they can experience problems like any 
other machine. When something goes wrong with your Mac, use 
this book to discover the solution. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to 
buy a new copy to read it more carefully or to keep it for reference. 
Discounted classroom and Mac user group copies are also available. 

Copyright © 2011, Joe Kissell. All rights reserved.
 

Updates and More
 

You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to 
purchasers). On the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 
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Basics
 

Here are a few “rules of the road” that will help you read this book:
 

•	 Lion: At publication time, Apple had not yet released Mac OS X 
10.7 Lion, but developer preview versions were widely available. 
Although Apple’s non-disclosure agreement prohibits developers 
with access to the software from publicizing any details about it, 
the rule doesn’t preclude mentioning information that has already 
become public (even if that happened without Apple’s permission). 
As a result, everything I say in this book about Lion simply repeats 
what has already been posted publicly on numerous Web sites. Be 
aware, however, that the final version of Lion may be different from 
what I describe here. 

•	 Big cats: I frequently mention features specific to a particular 
version of Mac OS X, which Apple usually refers to by a “big cat” 
code name: 

‣	 Lion: Mac OS X 10.7 

‣	 Snow Leopard: Mac OS X 10.6 

‣	 Leopard: Mac OS X 10.5 

‣	 Tiger: Mac OS X 10.4 

‣	 Panther: Mac OS X 10.3 

To find out which version of Mac OS X your Mac is running, follow 
the directions in Get System Information. 

•	 Menus: Where I describe choosing a command from a menu in 
the menu bar, I use a compact description. For example, to create 
a new folder in the Finder, you choose New Folder from the File 
menu; I abbreviate this by saying “File > New Folder.” 

•	 Contextual menus: In Mac OS X, when you hold down the 
Control key and click, a pop-up contextual menu appears, with 
commands appropriate to whatever is under the mouse pointer. 
For example, if you Control-click a file in the Finder, you’ll see 
commands such as Get Info, Duplicate, and Make Alias. Control-
clicking nearly always works to open a contextual menu, but your 
mouse or trackpad might support a better method. The default 
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behavior, the alternative methods, and the ways to set them vary 
depending on the type of input device; the typical alternative (for 
right-handed users) is to right-click with a mouse—click the right-
hand mouse button—so that’s the term this book uses by default 
for the action that opens a contextual menu. 

•	 Finding System Preferences: I sometimes refer to settings in 
System Preferences that you may want to adjust. To open System 
Preferences, click its icon in the Dock or choose Apple  > System 
Preferences. When the System Preferences window opens, click the 
icon of the pane whose settings you want to adjust. I refer to these 
panes using an abbreviated notation such as “the Network 
preference pane.” 

•	 Finding an application’s preferences: I often refer to 
preferences in an application that you may want to adjust. Don’t 
confuse an application’s preferences with the system-wide settings 
found in System Preferences. For example, in the program Disk 
Utility, you would choose Disk Utility > Preferences. 

•	 Path syntax: This book occasionally uses a path to show the 
location of a file or folder in your file system. For example, Mac 
OS X stores most utilities, such as Terminal, in the Utilities folder. 
The path to Terminal is: /Applications/Utilities/Terminal. 

The slash at the beginning of the path tells you to start from the root 
level of the disk. You’ll also see paths that begin with ~ (tilde), which 
is a shortcut for the user’s home directory. For example, if a person 
with the user name joe wants to install fonts that only he can access, 
he’ll put them in his ~/Library/Fonts folder, which is just another 
way of writing /Users/joe/Library/Fonts. 

•	 Hidden ~/Library folder in Lion: The ~/Library folder, which I 
refer to frequently in this book, is hidden by default in Lion. To view 
it in the Finder, choose Go > Go to Folder, enter ~/Library, and click 
Go. Or, to unhide it permanently, open Terminal (in /Applications/ 
Utilities) and enter chflags nohidden ~/Library (you can reverse 
the command by using hidden instead of nohidden). 

•	 Volumes and partitions: I follow Apple’s terminology in 
referring to any disk or partition on a disk as a volume. So if a hard 
disk has not been partitioned, it has just one volume. If a disk has 
been partitioned, each partition is a volume. 
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A Note about My Mac Fitness Books 

This book is one of three I’ve written that involve keeping your Mac 
healthy and fit. Inevitably, they all overlap slightly, but they have 
different emphases: 

✦	 This book is about solving problems that prevent your Mac from 
operating properly. It includes basic troubleshooting procedures, 
ready-made solutions to common complaints, and techniques that 
can help you diagnose and treat issues the book doesn’t cover 
specifically. 

✦	 Take Control of Maintaining Your Mac focuses on preventive 
maintenance—avoiding future problems, reducing clutter, making 
your Mac easier to use, and monitoring its ongoing health. 

✦	 Take Control of Speeding Up Your Mac goes into great detail about 
ways to increase your Mac’s performance, returning to (or even 
surpassing) the speed it had when it was brand new. This includes 
finding and taming rogue processes, improving disk and CPU 
responsiveness, installing hardware upgrades, optimizing your 
wireless network, and many other tasks that contribute to overall 
speed. 

What’s New in The Second Edition
 

In the roughly two years since the previous version of this book was 
released in 2009, Mac OS X has undergone lots of changes, as have 
third-party tools. In addition, I’ve accumulated more troubleshooting 
advice I wanted to share. As a result, I’ve made extensive changes in 
this edition. Some of the most significant changes include: 

•	 Information on Apple’s USB Software Reinstall Drive, other flash 
drives, and Lion’s Recovery HD volume in Acquire a Secondary 
Startup Volume 

•	 Suggestions for alternative ways to Start Up from Another Volume 

•	 Updated instructions (for 10.6 Snow Leopard and later) in Erase 
and Restore from Backup 

•	 A thoroughly revised list of resources in Reset PMU, SMU, SMC, 
NVRAM, or PRAM 
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•	 Improved guidelines and updated information in Check Free Disk 
Space 

•	 Revised instructions (now supporting Snow Leopard and later, and 
Microsoft Office 2011) in Clear Caches 

•	 Expanded information about bad RAM in Your Computer Keeps 
Turning Itself Off 

•	 Additional suggestions about what to do if You Experience 
Repeated Kernel Panics 

•	 Drawing from Take Control of Speeding Up Your Mac, a revised 
discussion of easy things to try if Your Mac Is Abnormally Slow 

•	 Ready-to-use solutions to even more common problems: 

‣	 Spotlight Searches Fail 

‣	 Keychain (Seemingly) Forgets Passwords 

‣	 Apple Mail Fails to Connect 

‣	 Time Machine Misbehaves 

‣	 A Volume Won’t Unmount 

•	 Updated information about Apple’s support offerings in Ask the 
Vendor for Help 
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Introduction: Don’t Panic!
 
You’ve always heard that Macs are easy to use and less prone to 
misadventures than Windows PCs. And that’s true. But they’re still 
only machines. And sure enough, one day it happens: you encounter a 
serious problem with your Mac and have no idea what to do. Perhaps, 
since you’re reading this book, that day is today. 

Repeat after me: Everything is going to be all right. Now take a deep 
breath and try again, this time with feeling! Everything is going to 
be all right. I want you to believe that. Even if you’re feeling panicked 
right now because your Mac is doing something wonky and you’re 
facing a deadline, I want you to set aside your anxiety for a moment. 

Almost every Mac problem you may encounter has a solution. True, 
some solutions are more elusive, more time-consuming, or more 
expensive, than others, but still: don’t worry. I’ve been solving 
problems with Macs for more than 20 years, and I’m here to tell 
you that solutions come more easily when you have a clear head and 
approach a problem systematically. That’s what this book helps you 
to do. 

Make yourself a nice cup of tea. (Keep the tea away from your Mac, 
by the way—let’s not add to your problems, eh?) Close your eyes and 
think happy thoughts. Then page through this book to learn the most 
efficient way to deal with whatever difficulties you may be having. 

I’ve seen more than one Mac troubleshooting book that was upward 
of 600 pages long, and troubleshooting Web sites with thousands 
of pages of suggestions. By contrast, this book makes no attempt to 
be comprehensive, because merely listing vast numbers of problems 
and their accompanying solutions doesn’t help one bit if you have 
a different problem or don’t realize how your problem is like some 
other one. What I hope to do, instead, is show you some handy 
troubleshooting techniques, provide instructions for solving several 
common problems, and then help you figure out what to do when 
a problem’s cause or solution isn’t immediately apparent. In other 
words, I want to teach you how to be your own technical support 
person—to do what I do when something goes wrong with one of 
my Macs. 
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Because my focus here is on getting your Mac back into working order, 
I intentionally skip over lots of background information and technical 
details. So don’t worry if you’re unsure exactly why some technique 
solves your problem. If you’re really interested in the deep background, 
some exploration on the Web will probably turn up oodles of detail. 

As confident as I am that most Mac problems have straightforward 
solutions, I must point out that some problems can’t be solved with a 
few mouse clicks or other clever fiddling. If flames are shooting out of 
your Mac or the screen is in a thousand pieces, you’ll need more help 
than I can provide here. Even simpler hardware problems, such as a 
faulty component on your logic board or a busted power cable, may 
require a trip to the repair shop. And a few—very few—hardware 
problems are either entirely beyond repair or more costly to repair 
than is worthwhile. Nevertheless, don’t panic. By the time you finish 
this book, you’ll not only know how to solve most problems, you’ll 
have the tools and techniques you need to prevent many problems in 
the first place, or at least to nip them in the bud. And even if you have 
a problem that requires professional help, following the steps in this 
book will help you talk to a repairperson more effectively. 

If you don’t have any problems right now and are merely reading this 
to prepare yourself for future mishaps, good for you! You’ll especially 
appreciate the information in the first couple of chapters about 
preventing problems and preparing for an emergency. 

This book is designed to help troubleshoot problems with any version 
of Mac OS X from 10.4 Tiger onward, though many of the techniques 
also work with older versions. At press time, Mac OS X 10.7 Lion 
hadn’t yet been released, but based on my preliminary testing with 
preview versions, I expect that nearly everything in this book will 
continue to work with it. Use the link in Ebook Extras, near the end 
of the book, to check for any new information or updated versions of 
this book. 

Font of knowledge: One large category of Mac trouble I don’t 
cover here is font misbehavior. If you need help troubleshooting a 
font-related problem, read Sharon Zardetto’s Take Control of Font 
Problems in Leopard. It hasn’t been revised in several years, but it 
remains the only book on the market about font problems and much 
of its advice is still worthwhile. 
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Troubleshooting 
Quick Start 
When your Macintosh has problems, you undoubtedly want to 
jump right to the solution. So feel free to skip immediately to Solve 
Common Problems and see if your symptom is listed there. If not, 
and time permitting, I recommend reading this book in order, 
because earlier sections provide useful background information for 
later sections. However, you may also try the steps in Troubleshoot 
Novel Problems, following the cross-references as necessary to 
earlier parts of the book where certain procedures are described 
in detail. 

Prepare for Trouble 
•	 Even if your Mac is healthy now, take steps to keep it that way. Read 

Prevent Problems. 

•	 When your Mac starts acting up, you’ll be glad to already have a 
toolkit with which you can diagnose and fix it. Learn what you need 
to have on hand in Prepare for an Emergency. 

•	 Most of the steps you’ll go through when a problem occurs rely 
on several common procedures. Learn how to do these tasks before 
problems arise so that fixing them will be easier. See Learn Basic 
Troubleshooting Procedures. 

Solve Problems 
•	 If your Mac misbehaves, the problem may be something that many 

other people have experienced (and that’s easily repaired). Start 
with Solve Common Problems. 

•	 Not all problems are common. If you encounter something not 
covered in the previous section, learn how to solve it—or find 
someone who can—in Troubleshoot Novel Problems. 

Find More Information 
•	 For further instruction in troubleshooting, check out the electronic 

or printed books in Learn More. 
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Prevent Problems
 
Although this book is mainly about solving problems, not 
preventing them, I’m sure you don’t want any issues you’ve fixed 
to recur. And a few preventive steps can make solving problems 
much, much easier if and when they do occur. 

At the risk of sounding overly promotional, I would like to note 
that some of my other books (chiefly Take Control of Mac OS X 
Backups and Take Control of Maintaining Your Mac) offer a great 
deal of advice that will help you prevent problems, and I certainly 
recommend those titles if you need additional help. In this chapter, 
though, I cover three particularly important preventive 
maintenance tasks. 

Use a Surge Protector or UPS
 

Surge protectors are to a computer what airbags are to a passenger in 
a car. No matter how carefully you drive, another driver could cause a 
collision—and that airbag could save your life. Likewise, no matter how 
clean or reliable the power in your building normally is, a lightning 
strike or power surge could damage components or even wipe out your 
computer. It’s unlikely, but it can and does happen. 

Considering how inexpensively you can buy a surge protector, using 
one is common sense. If you haven’t already done so, spend a few 
dollars to prevent hundreds or thousands of dollars worth of damage. 
(Still, don’t buy the cheapest surge protector you can find, which may 
not offer enough protection. Get one that includes a warranty covering 
damage to your computer in the event of a power surge.) 

Path of least resistance: A lightning strike can also travel through 
phone lines, Ethernet cables, USB cables, or any other conductor. If 
your computer has phone or Ethernet cables attached, I recommend 
purchasing a surge protector with the necessary jacks to protect your 
computer from these additional sources of potential damage; I also 
recommend plugging any attached USB devices into a surge 
protector or UPS. 
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Much better yet, if you can afford it (and they’re not terribly 
expensive), is an uninterruptible power supply (UPS), which includes 
not only significantly better protection from power surges but a battery 
that can keep your Mac running for minutes or hours during a power 
interruption. Models from APC and Tripp Lite work with Mac OS X’s 
Energy Saver preference pane to shut the Mac down automatically in 
case of power failure. Bear in mind, however, that UPS batteries must 
be replaced every 3–5 years—a potentially awkward and expensive 
undertaking. 

For more information and to determine the size of UPS you would 
need, visit http://www.apc.com/ or http://www.tripplite.com/. 

Back Up Your Mac Regularly
 

Statistically speaking, your odds of having some sort of problem with 
your computer that results in a loss of data are high. It may not happen 
for years, but if and when it does, the consequences can be devastating. 
Crucially for our purposes in this book, some of the troubleshooting 
and repair techniques I cover here assume that you have a backup 
from which you can restore your data in the event of a serious problem. 
So if you’ve never set up a backup plan, don’t delay. Start today! 

Backups come in all shapes and sizes. I advocate an approach that 
includes a couple of different backup types, having redundant backups, 
and storing your media off-site. But if I had to choose just one sort of 
backup, it would be a bootable duplicate—an exact copy of your startup 
volume, stored on another hard disk, and configured in such a way that 
you can boot from that backup drive in the event of an emergency. 
Ideally, you should update this bootable duplicate at least once a week 
so that it reflects the files that have been added or changed since the 
last run. 

Lots of software tools provide easy ways to make bootable duplicates. 
My favorites are: 

•	 Shirt Pocket’s SuperDuper: http://www.shirtpocket.com/ 
SuperDuper/ ($27.95) 

•	 Bombich Software’s Carbon Copy Cloner: http:// 
www.bombich.com/software/ccc.html (free, donations requested) 
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Keep Your Software Up to Date
 

Bugs—either in Mac OS X itself or in some application you have 
installed—are perhaps the biggest causes of Mac problems. Each 
new software release fixes bugs, so keeping your software up to date 
is an excellent way of reducing the number of problems you have. 

At the same time, each new software version often introduces new 
bugs! The release after that fixes those bugs and adds more new ones, 
and so on. That’s just how it is, I’m afraid: there’s no such thing as bug-
free software. 

In my experience, newer software is almost always better than older 
software. A couple of times, I’ve applied an update and immediately 
regretted it enough to revert to the previous version (which sometimes 
means reinstalling software from scratch and then applying every 
update except the most recent one). But these times have been 
exceptionally rare. The vast majority of the time, I’m happier after 
applying an update than I was before. 

So in general, my advice is to keep up with new software releases— 
including Mac OS X itself (minor updates are available by choosing 
Apple  > Software Update) and third-party applications. In 
particular, if you start experiencing crashes, hangs, and other sorts 
of misbehavior, I recommend updating your software right away. Most 
applications have a Check for Updates (or similar) command, and if 
you downloaded the software from the Mac App Store, you can open 
the App Store application and click Updates in the toolbar to find and 
install updated versions. 

I understand and respect the “if it ain’t broke, don’t fix it” school of 
thought. Sure, I’ve heard of people who were computing quite happily 
until some software update came along and messed things up for them, 
causing them hours or days of grief. Yes, that can happen. But the odds 
favor improvements with each update. So, at the very least, think about 
installing software updates you may have skipped when you encounter 
problems. But if you’re willing to undertake a small amount of risk for 
a potentially large reward, do what I do and keep up with every new 
update. 
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Prepare for an Emergency
 
You probably carry a spare tire, a jack, and jumper cables in your
 
car (perhaps along with the phone number for roadside service).
 
These sorts of basic problem-solving tools are just common sense.
 
If you don’t have comparable tools for your Mac, you’ll be in a pickle
 
if and when a problem occurs. Don’t get stranded without the
 
means to get back up and running again.
 

All the items mentioned in this chapter can come in handy when a 
problem occurs. You might not use them all, but I’ve used each of 
them at one time or another, and I’ve found them all to be sound 
investments. 

Acquire a Secondary Startup Volume
 

You can’t replace your car’s oil filter while the engine is running— 
it would not only be messy but it could potentially ruin the engine. 
Similarly, some repairs can’t be done when your Mac is running from 
a disk that’s experiencing problems. In these cases, you must start your 
Mac from another volume. You may also need to start from another 
volume if your internal hard drive dies completely. 

A secondary startup volume can take numerous forms. I prefer an 
external hard drive with FireWire and USB interfaces, because it’s 
fast, flexible, and can be used for things other than starting up in an 
emergency. But that is just one of several options. Be sure you have 
at least one of these handy: 

•	 A bootable CD or DVD, such as a Mac OS X Install DVD or an 
emergency repair disc from a third party. Examples include: 

‣	 DiskTools Pro: http://www.macwareinc.com/products/
 
DiskToolsPro/overview.html ($79.99)
 

‣	 DiskWarrior: http://www.alsoft.com/DiskWarrior/ ($99.95) 

‣	 Drive Genius: http://www.prosofteng.com/products/
 
drive_genius.php ($99)
 

‣	 TechTool Pro: http://www.micromat.com/ ($99.99) 
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•	 The USB Software Reinstall Drive included with certain Macs (such 
as the MacBook Air and the Mac mini server) that lack an optical 
drive 

•	 A USB flash drive, or even an SD card (for Macs with built-in SD 
card readers), on which you’ve installed a bootable copy of Mac 
OS X. 

•	 A suitably partitioned external Thunderbolt, FireWire, or USB hard 
drive or flash drive—see the sidebar Partitioning Schemes, just 
ahead, for details. (Note that only Intel-based Macs can boot from 
USB drives.) 

Pod people: Some iPods can also be used as startup disks, as long 
as they have enough free space and an interface appropriate for 
your computer. Note that iPod hard disks weren’t designed to run 
continuously for any amount of time, so it’s fine to use one as an 
emergency repair disk, but don’t work from it regularly. You can 
learn more about starting up from an iPod in this article from 
Apple: http://support.apple.com/kb/HT1478. 

Partitioning Schemes 
A drive’s partitioning scheme describes things like how many volumes 
the drive has, how large they are, and where they’re located. Even 
if a disk has only one partition, it must use the correct partitioning 
scheme to be bootable. The choices are GUID Partition Map (the 
default for Intel-based Macs), Apple Partition Map (APM) (the only 
scheme supported for PowerPC-based Macs), or Master Boot Record 
(which is never bootable on a Mac). An APM-partitioned drive can 
boot either a PowerPC- or Intel-based Mac, but a GUID-partitioned 
drive can boot only an Intel-based Mac. To select a scheme when 
partitioning a drive in Disk Utility, click the Partition button, click 
Options, and select the appropriate radio button. 

•	 Another Mac that can boot into FireWire target disk mode— 
assuming both Macs have FireWire ports. (To make this work, 
connect the Macs with a FireWire cable, restart the one whose disk 
you want to boot from, and hold down the T key until you see the 
FireWire icon; see http://support.apple.com/kb/HT1661.) 
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•	 For MacBook Air and Mac mini server users, either an external 
SuperDrive or another computer (Mac or PC) on the local network 
(wired or wireless) with Apple’s Remote Disc software installed. 
(I describe the latter setup later, in Start from a Remote Disc.) 

•	 A second internal drive (in a desktop Power Mac or Mac Pro). 

•	 A second partition of your main startup disk—or, for Lion users, 
the Recovery HD volume created by the Mac OS X Installer. 

Piece of the action: A second partition is the least useful for 
troubleshooting, because it doesn’t enable you to solve problems 
that affect the entire disk. 

If your secondary startup volume is a Mac OS X Install disc, an up-to-
date third-party repair disc, or Recovery HD volume, then you’re all 
set. But if you’re using another disk or partition, you must make sure 
it contains a bootable copy of Mac OS X. You can do this in any of the 
following ways: 

•	 Clone your internal drive: Using backup software designed 
for this task, make an exact copy of your main startup disk on 
the secondary disk. Tools that work well for this purpose include 
SuperDuper (http://www.shirtpocket.com/SuperDuper/) and 
Carbon Copy Cloner (http://www.bombich.com/). 

•	 Install Mac OS X directly: In many cases you can insert your 
Mac OS X Install media and run the installer, selecting your 
secondary disk as the destination. 

After setting up your secondary startup volume, be sure to test it 
to verify that it is bootable; you don’t want to find out that it’s not 
working after your main drive dies. Read Start Up from Another 
Volume for more details. 

Note: As I describe ahead, in the sidebar AppleJack, a command-line 
utility called AppleJack also provides a way to repair one’s hard drive, 
and doesn’t require a separate volume to do so—but it’s also limited 
in the range of repairs it can make. 
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Get a Disk-Repair Utility
 

Over time, almost every disk develops some minor errors that can 
cause your Mac to behave badly. The specific causes and symptoms 
are numerous, but when disk errors occur, your only option is to use 
a utility that’s specially designed to examine your disk at a low level 
and repair the problem. (In order to perform most repairs, you must 
run the disk utility from your secondary startup volume. See Run Disk-
Repair Utilities for further instructions.) 

Apple includes a basic disk utility called (you guessed it) Disk Utility 
with Mac OS X. It’s found in /Applications/Utilities and also appears 
on every Mac OS X Install disc. If you clone your startup volume or 
install Mac OS X directly onto another disk, you already have one disk 
repair utility ready to go. 

I use Disk Utility frequently, because it’s a quick and easy way to 
solve a number of problems and is considered to be extremely safe. 
But some disk errors are too complex for Disk Utility to repair, and 
unfortunately, such errors are not uncommon. So I recommend, if 
at all possible, having a second disk repair utility available—one that 
can pick up where Disk Utility leaves off. In my opinion, only four 
are worth any serious consideration: 

•	 DiskWarrior: My favorite by far, this $99.95 utility from Alsoft 
can solve some problems no other utility can. It’s been around for 
over 20 years, and has only gotten better over time. If you can buy 
only one disk utility, get this one (http://www.alsoft.com/ 
DiskWarrior/). 

•	 TechTool Pro: Micromat’s $99.99 flagship repair utility not 
only repairs disks but also checks your RAM, video card, and other 
hardware components (http://www.micromat.com/index.php? 
option=com_content&task=view&id=202). 

•	 Drive Genius: Prosoft Engineering’s $99 Drive Genius doesn’t 
have the same long history as the other two candidates, but it has 
a solid feature set, and can repartition hard disks without erasing 
their data (http://www.prosofteng.com/products/ 
drive_genius.php). 
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•	 DiskTools Pro: This relative newcomer from Macware has a full 
complement of disk-repair capabilities, but I haven’t heard much 
one way or another about its real-world effectiveness (http:// 
www.macwareinc.com/products/DiskToolsPro/overview.html, 
$79.99). 

Each of these comes with a bootable emergency DVD (if purchased in 
a box), and can be installed on your secondary startup volume. 

AppleJack 

There’s a (partial) exception to the rule that you can’t repair the 
disk you’re booted from. If you install the free command-line utility 
AppleJack, available from http://applejack.sourceforge.net/, you can 
run several basic disk repair procedures (essentially the equivalent 
of Disk Utility’s Repair Disk and Repair Disk Permissions features, 
plus clearing cache and virtual memory swap files, and checking 
preference files for validity) by booting your Mac in single-user mode. 

To do this, hold down Command-S while restarting until the Apple 
logo appears. Your screen then fills up with text, and when the boot 
process has finished, you type applejack, press Return, and follow 
the on-screen prompts. 

AppleJack is well worth installing so that you have it ready as an 
alternative repair method in the event you’re stuck without another 
startup disk for some reason. However, be aware that AppleJack 
is much less capable than commercial utilities such as DiskWarrior 
and TechTool Pro, and that it can’t help you if the portion of your disk 
that contains the AppleJack software itself (or certain other essential 
components) is corrupted—or if the drive mechanism is physically 
damaged or electronically malfunctioning. Given the choice, I always 
recommend starting from another volume and using a full-featured 
repair program. 

20
 

http://www.macwareinc.com/products/DiskToolsPro/overview.html
http://www.macwareinc.com/products/DiskToolsPro/overview.html
http://www.macwareinc.com/products/DiskToolsPro/overview.html
http://www.macwareinc.com/products/DiskToolsPro/overview.html
http://applejack.sourceforge.net/
http://applejack.sourceforge.net/


       
        

       
     

      
   

     
      
           

           
       

       
       

     

    

         
          

           
            

            
     

            
          

          
         

              
            

 

         
         

    
      

A Little Something Extra 

If you want a truly complete troubleshooting toolkit, consider adding 
a few optional items to help with certain specific problems. For 
example: 

✦	 A spare keyboard and mouse: If your input devices aren’t 
working, it’s hard to do anything with your Mac—including 
troubleshooting. Even old, cheap, or used input devices are good 
enough for emergency use. 

✦	 Extra cables: When you’re troubleshooting network problems, 
a spare Ethernet cable is handy. When peripherals malfunction, 
an extra USB or FireWire cable can help you rule out a bad cable 
as the cause. As a bonus, a FireWire cable can be used to network 
two Macs together if they both have FireWire ports. 

✦	 Batteries: If you use Bluetooth devices or other wireless 
accessories, have a spare set of batteries available. Batteries have 
a way of dying at the most inopportune times! 

Set Up Another User Account
 

Your home folder (/Users/your-user-name) contains all the files that are 
specific to your account, including not only your documents, pictures, 
and music but preference files, caches, and certain kinds of application 
support files and system add-ons. If you’re the only person who uses 
your computer, you may have only one login account and therefore just 
one home folder on your computer. 

Regardless of how many users your Mac has, I suggest setting up 
another account that you’ll use solely for troubleshooting. That way, 
when a problem arises, you can easily switch to the other account— 
which will have default settings for everything—and see whether the 
problem still occurs. If it doesn’t, you know the cause is to be found 
somewhere in your home folder, and you can begin narrowing it down 
from there. 

Tip: To learn all about user accounts, including much more detail 
on how to use a troubleshooting account to check for things like 
conflicting login items and preference files, read Kirk McElhearn’s 
Take Control of Users & Accounts in Snow Leopard. 
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To set up a troubleshooting account, follow these steps: 

1. Open the Accounts pane of System Preferences (called the Users 
& Groups pane in 10.7 Lion). 

2. Click the lock icon and enter your user name and password. 

3. Click the plus button just below the list of accounts. 

4. Enter the requested information: name, short name, password 
(repeated for verification), and an optional password hint. 

5. In 10.4 Tiger, be sure the Allow User To Administer This Computer 
box is checked; in 10.5 Leopard or later, choose Administrator from 
the New Account pop-up menu. 

6. Click Create Account. 

What’s in a name: Your troubleshooting account won’t do you 
much good if you can’t remember its user name or password. So pick 
things you’ll remember. Something as simple as “Test User” for the 
long name and “test” for the short name is fine. 

Because this new user has administrative privileges, the password 
should be as secure as the one set for your own account—an easy 
password (like “test” again), puts your Mac at risk. My advice: set the 
same password that you use for your normal administrator account 
to make it memorable yet secure. 

Consider Purchasing AppleCare
 

The AppleCare Protection Plan is essentially an extended warranty 
you can buy for a new Mac. Normally, Apple offers a 1-year limited 
warranty on its computers, including 90 days of telephone support. 
AppleCare extends the warranty (and the telephone support) to a full 
3 years. Previously, AppleCare also included a bootable CD or DVD 
with TechTool Deluxe (a stripped-down version of TechTool Pro), 
but that’s no longer true. 

Depending on which equipment you purchase, AppleCare can 
cover peripherals (such as displays and AirPort base stations), 
and for desktop Macs, it even includes onsite service in most areas. 
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The cost for AppleCare depends on your hardware; it ranges from 
$149 (for a Mac mini) to $349 (for a laptop). 

I can’t emphasize strongly enough what a great idea AppleCare is. 
During one recent year, my mother, my wife, and I all had faulty iMac 
logic boards replaced—at no additional cost—thanks to AppleCare; 
without it, the machines would have been out of warranty and we 
would have spent many hundreds of dollars for the repairs. It’s 
especially useful (though more expensive) for laptops, which tend to 
be more trouble-prone than desktop computers. If you don’t live close 
to an Apple Store or an authorized repair center, Apple will send you 
a prepaid shipping container in which to return your laptop for repair. 

You can purchase AppleCare when you buy your computer, or at 
any time before your initial 1-year warranty expires. You don’t have 
to buy it from Apple; some resellers, such as Small Dog Electronics 
(http://www.smalldog.com/), often sell it for less than Apple does. 
Because it provides not only hardware repairs but also (usually) 
competent telephone tech support, I heartily recommend AppleCare 
to everyone buying a new Mac. 

Go Pro 

If you live near an Apple Store, consider buying a $99 annual 
subscription to Apple’s ProCare service (http://www.apple.com/retail/ 
procare/). ProCare includes numerous benefits for Apple Store 
customers, including priority service at any Genius Bar, faster repairs, 
and an annual Mac tune-up. The plan covers up to three computers 
registered in your name. Although ProCare doesn’t cover out-of-
warranty hardware repairs, it can be a faster and more effective way 
than AppleCare to get technical support. (And, of course, you can 
sign up for both programs if you wish.) 

Think about an Insurance Policy
 

I realize this is a somewhat different category of preparation, but there 
are some serious computer problems—such as theft or accidental 
breakage—that no amount of troubleshooting can fix. To protect your 
investment in cases like these, consider buying a special insurance 
policy just for your computers. 
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You may already have homeowner’s or renter’s insurance that covers 
your computer in the event of fire, flood, or burglary. But read your 
policy carefully, since you may be surprised to learn that many 
common types of loss are usually not covered—things like accidental 
damage or theft from a car. (And, in cases like these, your Apple 
warranty or AppleCare plan is of no use either.) Policies geared 
specifically for computers can fill that gap. 

A true story: a number of years ago, I was carrying a PowerBook in a 
padded laptop bag. The bag slipped off my shoulder and hit a rock, and 
the computer’s display cracked. Because I had a computer insurance 
policy, though, I saved hundreds of dollars on the costly repair—even 
after factoring in the deductible and the cost of the policy itself. 

Safeware (http://www.safeware.com/) is the best-known source for 
computer insurance in the United States. They offer a range of policies 
that cover desktops, laptops, and peripherals, and they even include 
coverage for theft from an unattended vehicle. In the UK, comparable 
policies are available from companies like Insure & Go (http:// 
www.insureandgo.com/computer-insurance.html) and CompuCover 
(http://www.compucover.co.uk/). 

Find Extra Help
 

Last but not least, figure out whom you can call or email for advice 
when you can’t solve a problem on your own (even with this book). 

Phone a Friend 
If you ask around, you may find someone in your existing circle of 
contacts who knows a thing or two about solving Mac problems. But 
if your go-to person is a friend or family member (in other words, 
someone who doesn’t charge for their services), I have three additional 
pieces of advice: 

•	 Don’t start with a problem: Ahead of time—when your Mac is 
working—ask your friend if he or she is willing to field occasional 
tech support questions. You might even invite the person over to 
dinner to get acquainted with your setup in advance. 
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•	 Don’t abuse free help: Even the most knowledgeable and 
generous friends can get annoyed when requests for help are too 
frequent or too time-consuming. 

•	 Return the favor: As someone who has provided more than his 
fair share of free tech support to friends and family, I can’t tell you 
how much it improves my attitude when someone returns the favor 
in even a small way. I’ve had people invite me out to lunch; offer 
accommodations when I’m traveling in their area; lend me their car 
for a day; and send me coffee, chocolate, CDs, and other thank-you 
gifts. Small gestures like these are good for relationships as well as 
your computer’s health! 

You’re my friend, aren’t you, Joe? I always include my email 
address in my books, and countless people have written to make 
comments, ask questions, or suggest new topics to cover. That’s 
wonderful—I enjoy hearing from readers, and I do my best to reply 
as quickly as I can. However… 

Occasionally a simple inquiry, especially when it comes to 
troubleshooting, turns into a lengthy series of questions. I’ve even 
had strangers email or phone me—at all hours of the day and night— 
begging me to help solve a problem that appears to be related in some 
way to a book or article I’ve written. I don’t mind answering brief 
questions, but I don’t have the time to provide technical support to 
everyone who asks. So I hope you’ll understand that I must decline 
to offer personalized troubleshooting assistance. 

Ask at a User Group 
At Mac user groups all over the world, ordinary folks meet to learn 
about the latest products, find better ways of working, and help each 
other solve problems. I’ve been an active member of several user 
groups over the years, and I frequently give presentations at user 
group meetings (usually covering topics I’ve written about for Take 
Control). Most user group meetings are open to the public, and some 
offer additional benefits for paid members. To find a user group in 
your area, see http://appleusergroupresources.com/?page_id=394. 
(That page also lists groups that meet only online.) 
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Find a Consultant 
If you don’t know anyone who’s a Macintosh expert or have a local 
Mac user group, never fear. Thousands of independent consultants 
make their living solving Mac problems. These folks may not be able 
to perform certain kinds of hardware repairs (see Go to the Source, 
below, if that’s what you need), but they can fix most Mac problems 
you encounter. 

To find an Apple-certified consultant in your area, search the Apple 
Consultants Network site at http://consultants-locator.apple.com/. 
Of course, lots of highly competent professionals offer Mac consulting 
services without having gone through Apple’s certification program. 
You can often find such folks in the Yellow Pages or by searching 
the Web. 

Call the doctor: Bob “Dr. Mac” LeVitus, a well-known Mac author, 
runs an online consulting service with a staff of highly trained 
troubleshooting whizzes. If your problem doesn’t require someone to 
be physically present, you may find that this service is just what the 
doctor ordered (http://www.boblevitus.com/). 

Go to the Source 
Some problems (particularly hardware defects) require special 
equipment, software, or training that only a certified Mac repairperson 
can provide. When that’s what you need, choose one of the following: 

•	 A Mac Genius: If you live near an Apple Store, you can talk 
your problems over with an Apple-trained expert at its Genius Bar. 
The advice is free, but if your Mac needs repairs and is not covered 
by a warranty or AppleCare, you’ll have to pay for parts and labor. 
At some busy Apple Stores, you may need to make an appointment 
to speak to a Mac Genius—call first or visit the store’s Web page if 
in doubt. Remember that paying $99 for ProCare, Apple’s priority 
support program at Apple Stores, helps you avoid the lines and get 
other benefits. See the tip Go Pro, a few pages earlier, for more 
information. 

•	 An Apple Authorized Service Provider: If there’s no Apple 
Store nearby, seek out a computer shop that’s authorized to provide 
warranty (or AppleCare) service on your Mac; they’re also the best 
(that is, least expensive) choice for out-of-warranty service. You can 
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search a directory of AASPs in the United States at http:// 
www.apple.com/buy/locator/service/; for AASPs in other countries, 
visit http://support.apple.com/kb/HT1434. 

Have an Accessible Copy of This Book
 

One last little detail. When it comes time to solve problems, you 
may not be able to use your Mac at all, so if you’re reading this ebook 
on your Mac, you won’t be able to refer to it. So, if you have a second 
Mac, an iOS device, Kindle, or some other gadget that can display 
ebooks, be sure to keep a copy of this book there. If not, consider 
printing the remainder of this book, or ordering a printed copy 
(use the link found in Ebook Extras, near the end of the book; it’s 
available only to purchasers—you’ll get a discount because you already 
bought the ebook). 

Tip: To quickly access your ebook on an iPad, iPhone, or iPod touch, 
open a Web browser app (such as Safari) and log in to your Take 
Control ebooks account at http://www.takecontrolbooks.com/ 
account. 

Note: For advice on moving a Take Control ebook to an iOS device, 
Kindle, or Nook, consult http://www.takecontrolbooks.com/device-
advice. 
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Learn Basic 
Troubleshooting 
Procedures 
If I were teaching you how to cook, I’d start by making sure you 
knew the basic techniques you’d be repeating many times: how to 
julienne vegetables, deglaze a pan, cream butter, roast poultry, and 
so on. That way, when we got to specific recipes later, I could simply 
say, “sweat the aromatics in butter and puree the tomatoes” without 
having to explain the meanings of words like “sweat,” “aromatics,” 
and “puree.” 

I want to do the same thing in this chapter: make sure you have 
a grasp of all the procedures that come up in many different Mac 
troubleshooting tasks. Then, when I describe the specific steps 
you’ll follow to solve various problems, I can say, “start up in Safe 
Mode” without having to spell out that process every time. And of 
course, you can always follow links back here if you need a reminder 
of what I’m talking about. 

If you’ve been using Macs for any length of time, you may raise your 
eyebrows at some of the procedures just ahead. “Restart Your Mac? 
Is he kidding? Who doesn’t know how to restart a Mac?” But please 
read through those sections anyway, because they include details 
that may not be obvious (such as what to do if the usual means of 
restarting doesn’t work). 

Restart Your Mac
 

Restarting is the most powerful Mac troubleshooting technique I 
know. This simple procedure can resolve a huge variety of crashes, 
hangs, and other problems. It may not be the first thing you should 
try (because it takes a few minutes), but it should certainly be high 
on your list. 
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When the need to restart arises, try each of these methods in turn until 
you succeed: 

1.	 The menu command: Choose Apple  > Restart. When the 
confirmation alert appears, click the Restart button. 

Quicker restarting: Another way to restart is to press your 
computer’s power button, which will cause your Mac to display a 
dialog with four buttons (Restart, Sleep, Cancel, and Shut Down). 
When this dialog appears, you can either click the Restart button 
or simply press the R key to restart immediately, without the 
confirmation alert. 

Mac OS X then instructs all running applications and background 
processes to quit. After a few seconds (or, in some cases, as long as 
a few minutes—if whatever’s running takes a while to respond), the 
screen goes blank, the startup chime plays, and the Mac restarts. 

In some situations, restarting in this way isn’t possible. Perhaps the 
Apple  menu won’t drop down, or your Mac is completely frozen 
and won’t respond at all. Or maybe the Restart command appears to 
take, but 10 minutes later the machine is still chugging away. When 
this happens, move on to… 

2.	 The keyboard shortcut: 

‣	 If your keyboard has a power button, hold down Command and 
Control and press the power button. 

‣	 If your keyboard doesn’t have a power button, hold down 
Command and Control and press the eject key (typically found 
in the upper right corner of the keyboard, and if it’s not labeled, 
try either F12 or F15). Usually this method causes your Mac to 
restart immediately. 

‣	 If that doesn’t work, try… 

3.	 The brute-force method: Press and hold the Mac’s power button 
(sometimes the power button on older Apple monitors works too) 
for approximately 10 seconds, or until the power light goes out 
completely. (If you don’t hold it long enough, you may just put your 
computer to sleep, as indicated by a pulsating power light.) Then 
press the power button again to turn your Mac back on. 
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Force-Quit an Application
 

When an application gets stuck and its regular Quit command won’t 
work, you can usually quit it using Mac OS X’s Force Quit feature. To 
do this, press Command-Option-Escape (or choose Apple  > Force 
Quit). Select the program you want to quit and click Force Quit. You 
can then close the Force Quit Applications window. 

Tip: You can often force-quit a stuck application without the Force 
Quit Applications window. One way is to Option-right-click (or 
Control-Option-click) its Dock icon and choose Force Quit from the 
pop-up menu to quit the application. Or, to force-quit the foreground 
application, hold down Command-Option-Shift-Escape for 3 seconds. 

Sometimes, even after you use the Force Quit command, a program 
keeps running. When this happens, a second attempt at force-quitting 
nearly always does the trick. Close the Force Quit Applications window 
if it’s still open, and repeat the force-quit procedure. 

If even the second attempt doesn’t work, or if you can’t bring up the 
Force Quit Applications window, your best bet is to Restart Your Mac. 

Finders keepers: The Finder appears in the Force Quit Applications 
window along with your other applications. But when you select it, 
the button changes from Force Quit to Relaunch. That’s because Mac 
OS X is designed so that the Finder is always running. If you quit it— 
which you may need to do if it gets stuck—it automatically attempts 
to open again. 

Start Up from Another Volume
 

If your main startup volume has problems that can’t be repaired while 
Mac OS X is running from it—or if the drive dies completely and you 
need to start from a bootable duplicate—use one of these procedures to 
start up from another volume. 

Tip: For ideas on what disc or hard drive to use for the following 
procedures, read Acquire a Secondary Startup Volume, earlier. 
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Start from a CD or DVD 
To start your computer from a CD or DVD, follow these steps: 

1. If your Mac is running, insert the disc containing a bootable copy of 
Mac OS X. Then choose Apple  > Restart, and skip to Step 3. 

2. If your computer is off, press the power key and immediately insert 
the disc. (On some Macs, you may have to press the Eject button on 
your keyboard to open the drive tray. Do this, and insert the disc, as 
quickly as you can.) 

3. Immediately hold down the C key on the keyboard. 

4. When the gray Apple logo appears in the center of the display, 
release the C key. 

Keep in mind that the startup process takes considerably longer with 
a CD or DVD than it does with a hard disk. 

Start from Another Local Volume 
If your secondary startup volume is on another hard drive, a flash drive 
or SD card, or a partition of your main disk, follow these steps: 

1. If you haven’t already done so, attach the drive to your computer. 

2. Restart, holding down the Option key until icons for all the valid 
startup volumes appear on the screen. (If your Mac refuses to 
display the startup volumes, restart again, this time holding down 
Command-Shift-Option-Delete.) 

3. Using the mouse or the arrow keys on the keyboard, select the 
volume from which you want to boot. Then: 

‣	 On an Intel-based Mac, click the arrow icon underneath the 
selected volume or press Return. 

‣	 On a PowerPC-based Mac, click the button with the right arrow 
icon or press Return. 

Note: When you choose a new startup volume using the method 
described here, that choice applies only once. The next time you 
restart, if you don’t hold down any extra keys, you’ll start up from 
your previously selected volume. To make the change in startup 
volume persist past a single restart, go to the Startup Disk pane of 
System Preferences and pick a new startup volume. 
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Start from a Recovery HD Volume 
If you have Lion installed along with its hidden Recovery HD Volume, 
restart while holding Command-R to start from that volume. Note that 
the Lion installer puts the recovery volume on the same disk as Mac 
OS X itself, so if you’re installing Lion onto an external hard drive, 
that’s where the recovery volume will be—and that drive must 
therefore be connected in order to be able to boot from the recovery 
volume. 

Start from a Remote Disc 
The MacBook Air was the first Mac in many years to include neither 
a FireWire port nor a built-in optical drive (even as an option), 
which reduces its range of startup options. Starting with the second-
generation MacBook Air released in 2010, it does include a USB 
Software Reinstall Drive. But if you have an older MacBook Air (or 
don’t have your USB drive handy, you still have another option. Unlike 
most Macs, the MacBook Air and the Mac mini server can boot over 
a network (a Wi-Fi network or, if you have the optional USB Ethernet 
adapter, a wired network) from a startup CD or DVD loaded on 
another computer—Mac or PC—on your network. 

To do this, you must first install the Remote Disc software (included 
with your MacBook Air or Mac mini server) on the other computer, 
following these directions on Apple’s Web site: http:// 
support.apple.com/kb/HT1777. Then, insert the disc you want to boot 
from in the other computer, and on your MacBook Air or Mac mini 
server, select that disc in the Startup Disk pane of System Preferences 
and restart. 

Note: If you don’t have another startup disk available but you did 
install AppleJack (see the sidebar AppleJack, earlier), you can restart 
while holding down Command-S to start in single-user mode and run 
AppleJack. 
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Run Disk-Repair Utilities
 

All the disk-repair utilities I mention in this book are easy to use.
 
In general, it’s simply a matter of booting from a secondary volume,
 
running the program (some of them launch automatically), selecting
 
a drive (or volume), and clicking a button. (Some applications let you
 
choose among a variety of tests to perform; when in doubt, run them
 
all!) Consult the documentation included with your utility for details.
 

I do want to point out one slightly tricky thing: running Disk Utility
 
from a Mac OS X Install CD or DVD. To do so, follow these steps:
 

1. Boot from the CD or DVD. 

2. Click through the language selection screen. 

3. Choose Utilities > Disk Utility. 

Erase and Restore from Backup
 

In the unlikely event that neither Disk Utility nor a third-party utility 
can repair the problems with your disk, your only option is to erase the 
disk and start over: 

•	 If you have a bootable duplicate, this is easy. Start up from the 
duplicate, use Disk Utility to erase your primary startup disk, and 
then use your duplication software to copy the backup back onto the 
disk you normally use. 

•	 If you don’t have a duplicate, make one if possible. (See Back Up 
Your Mac Regularly.) If your Mac won’t boot normally, you might 
still be able to boot it in FireWire target disk mode if it has a 
FireWire port. To do this, restart and hold down the T key until the 
FireWire icon screensaver appears. Run a FireWire cable to another 
Mac, and use an external hard disk attached to that Mac to make a 
duplicate of the ailing Mac’s hard disk. 

•	 If you can’t make a duplicate, back up your files as best you can. 
Then start up from your Mac OS X Install media. After clicking 
through the language selection screen, choose Utilities > Disk 
Utility. In the list on the left, select the volume you want to erase. 
Volume names (there may be one or more per disk) are shown 
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indented under the disk name, so be sure to select one of the 
indented icons. Click Erase, and confirm your selection. Then 
install Mac OS X normally. Be aware that this will erase everything 
on that disk—but at this point, you may have no other choice. 

Repair Permissions
 

Every file on your Mac has a collection of settings specifying which 
users can perform various actions with it (including reading, writing, 
and executing). The files that make up Mac OS X itself (including some 
Apple-installed applications) have very particular permission settings, 
and if they get changed from what they were originally, things can go 
wrong. For example, applications may refuse to open, printing may 
stop working, and you may even be unable to log in. 

Permissions don’t change themselves. Something has to happen to 
change them—such as running an improperly written installer or doing 
injudicious fiddling in Terminal. But whatever the cause, out-of-whack 
permissions can be nasty. 

Disk Utility includes a command to restore certain permissions 
to what they were originally. This command affects only about 50 
software packages (including the core elements of Mac OS X). It 
doesn’t change the permissions for any third-party software, and it 
only resets permissions to what they were originally—which could, 
in theory, have been wrong. So it’s not the cure-all that many pundits 
have proclaimed it to be, and I don’t recommend it as a preventive 
maintenance procedure. But it can solve real problems, including 
problems that involve third-party software (which depends on parts 
of Mac OS X that must, in turn, have the correct permissions). 

To repair your permissions, follow these steps: 

1. Open Disk Utility (in /Applications/Utilities). 

2. In the list on the left, select the disk or volume whose permissions 
you want to reset, as shown in Figure 1, where I’ve selected my 
SSD startup disk. (Permissions can be repaired only for volumes 
or disks containing Mac OS X.) 
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Figure 1: Repair permissions by selecting a disk and clicking the 
Repair Disk Permissions button. 

3. In the First Aid pane, click Repair Disk Permissions. 

Disk Utility displays messages about what permissions, if any, it resets 
in the status area. 

Repairing Permissions: The Great Debate 

No Mac troubleshooting procedure has received more press or been 
the subject of more debate—both pro and con—than Disk Utility’s 
Repair Disk Permissions feature. My experience is that repairing 
permissions occasionally solves random problems, and I am unaware 
of it having ever caused problems on my Macs. But it is by no means 
a panacea, nor is it the first thing I suggest trying when something 
goes wrong. 

The best account I’ve read about repairing permissions was by Take 
Control editor Dan Frakes: “Repairing permissions: What you need 
to know,” published in Macworld at http://www.macworld.com/article/ 
52220/. To learn more about permissions generally, read Brian 
Tanaka’s Take Control of Permissions in Snow Leopard. 
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Start Up in Safe Mode
 

As you use your Mac over a period of months and years, chances 
are you’ll install a variety of third-party software. Some of this software 
may include components that operate at a low level and must be 
running in the background all the time—things like drivers for third-
party input devices, certain backup programs, audio capture software, 
and utilities that monitor your Mac’s performance. All these things 
may load and run every time your start your computer without your 
ever being aware of them. And when they work, they’re great. But if 
something goes wrong with one of them, it’s not always clear what 
the problem is or how to turn off the offending software. 

For reasons like this, Apple provides a special way to boot into 
Mac OS X called Safe Mode (and getting into that mode is called 
performing a Safe Boot). A Safe Boot temporarily disables most 
of these third-party items (as well as several Apple products). In Mac 
OS X 10.4 Tiger or later, it also disables any login items (programs 
or documents listed in the Login Items view of the Accounts system 
preference pane), which normally open when you log in. Safe Mode 
also clears certain caches that would other load at startup. By turning 
off all these items, you can eliminate many potential glitches, and if 
the problem you were experiencing stops after a Safe Boot, you have 
some important clues as to what the culprit is. 

Safe Mode Details 

Apple’s Web site has complete information about what happens (or 
doesn’t) during a Safe Boot. If you want to know the details, see 
http://support.apple.com/kb/HT1564. 

To perform a Safe Boot, follow these steps: 

1. Turn off your computer. (Seriously: don’t just restart. Choose Apple 
 > Shut Down or press the power button, and click Shut Down in 
the dialog that appears.) 

2. Press the power key to turn your computer back on. 

3. As soon as you hear the startup chime, press the Shift key and hold 
it down until the gray Apple logo appears in the center of the screen. 
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Your Mac will complete the startup process, which may take 
considerably longer than usual. You’ll eventually see the words “Safe 
Boot” on the screen—possibly within the login window, depending on 
which version of Mac OS X you’re running. 

Turn Off Login Items
 

Although Safe Mode disables not only (system-wide) startup items 
but also (user-specific) login items, you may wish to disable only 
your login items. For example, if your problem went away during a 
Safe Boot, you might try a normal boot but with login items disabled, 
to narrow down which of the recently disabled items might be at fault. 

You could open the Accounts pane of System Preferences (or, in Lion, 
the Users & Groups pane), go to the Login Items view, and delete 
everything in the list, but don’t—it’s overkill, and it can be tedious to 
replace those items later. Instead, disable them temporarily: 

•	 If your computer is currently running: 

1. Choose Apple  > Log Out User-Name, and then click Log Out 
to confirm that you want to log out. 

2. Select (or type in) your user name and password. 

3. Click Log In, and then immediately press Shift. 

4. Release the Shift key when your Desktop appears. 

•	 If your computer is off: 

1. Press the power key to turn on your computer. 

2. Press and hold the Shift key at the correct time during the
 
startup process:
 

‣	 If you log in by entering your password, press the Shift key 
while clicking Log In. 

‣	 If you’ve configured your account to log you in automatically, 
then in 10.4 Tiger, press Shift as soon as the startup progress 
bar appears. In 10.5 Leopard or later, press Shift as soon as 
the gray Apple logo disappears; this disables automatic login. 
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In the login window, select (or type) your user name and 
password, and then press the Shift key while clicking the Log 
In button. 

3. When your Desktop appears, release the Shift key. 

Check Preference Files
 

When an application starts acting funny, one of the first things to 
suspect is a damaged preference file. There are two ways to discern 
whether a preference file has problems; we start with the easy way. 

Use Preferential Treatment 
A free utility by Jonathan Nathan called Preferential Treatment 
(http://www.jonn8.com/html/pt.html) scans all your preference 
files, looking for obvious syntax errors. If it finds a file with problems, 
it lets you delete it immediately or reveal it in the Finder so that you 
can disable it manually. 

To use Preferential Treatment: 

1. Quit the application that’s experiencing problems, and launch 
Preferential Treatment. 

2. Click the lock icon at the top, and enter your administrator 
password. Preferential Treatment immediately starts checking 
your user preference files (those stored in ~/Library/Preferences). 
If Preferential Treatment finds any preference files with potential 
errors, it lists them, with the errors in red. 

(Not every suspected error is a genuine problem. Some developers, 
for example, continue to use a now-obsolete file format. Figure 2 
shows an example.) 

Multiple birds, single stone: Preferential Treatment scans 
all your preference files, so it may identify problematic files for 
applications other than the one that’s currently misbehaving. But 
it doesn’t hurt to deal with those, too, as long as you’re here; that’ll 
reduce the risk of further problems later. 
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Figure 2: Preferential Treatment lists preference files that have 
potential errors; this may include some that merely use an old or 
nonstandard format (such as the ones shown here). 

3. Select a flagged preference file and choose your desired response 
from the pop-up action menu: 

‣	 If you’re certain that the file is damaged and that you can live 
without its contents, choose Move to Trash. (But be careful: 
trashing a preference file can require you to reconfigure an 
application and even, in some cases, re-enter your license code 
or other registration details.) 

‣	 Otherwise, choose Reveal in Finder, and then manually drag the 
file to your Desktop. 

4. Go to the System Preferences pane in Preferential Treatment. If the 
lock icon is locked, click it and enter your administrator password 
again; otherwise, click Check System Preferences. Preferential 
Treatment scans the preference files stored in /Library/Preferences. 

5. Repeat Step 3 with any flagged preference files. 

6. Reopen each application whose preference file you deleted or 
disabled in Step 3. The application creates a new, default preference 
file (or files) for itself. 
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7. Test the application to see if the problem still exists. If not, the old 
preference file was probably at fault, so you can trash the one on 
your Desktop. If the problem is still there, the preference file was 
probably good—so you can quit the application and drag the file 
from your Desktop back to where it came from. 

Preferential Treatment is easy to use, but it doesn’t identify all possible 
problems with preference files. For example, it doesn’t work on files for 
which the developer has used a nonstandard format, and it identifies 
only syntax errors—just one source of problems. If the results of using 
Preferential Treatment are inconclusive, your next step is to manually 
disable the preference file temporarily. 

Manually Disable Preference Files 
Before you can disable a preference file, you must find it. And that’s 
sometimes easier said than done. Most preference files live in one of 
two folders: ~/Library/Preferences or /Library/Preferences. Those 
folders, however, can contain hundreds or even thousands of items, 
and they may not conform to any obvious organizational scheme. 

Apple recommends that preference files follow a standard naming 
convention, known as reverse-domain name style. You take a 
company’s domain name and reverse it—apple.com turns into 
com.apple—and then you add the name of the application. Finally, you 
add the extension plist (for property list). So, com.apple.mail.plist 
is the preference file for Mail, and com.microsoft.Word.plist is the 
preference file for Word. That’s a bit weird, but at least it makes sense. 
Unfortunately, this system doesn’t always work: 

•	 Some developers use their own naming conventions. 

•	 Some applications have several different preference files, each for 
a different sort of data. These files might be stored in a folder inside 
your Preferences folders, or they might not—and if they are in a 
folder, there’s no telling what that folder might be named. (The 
name of the application and the name of the developer are two good 
initial guesses.) 

•	 Applications may change the formats or names they use for 
preference files from one version to the next, making it unclear 
which of several candidates is the right one. 
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•	 Your Preferences folders may contain files that are not preference 
files—log files, lists of recently opened documents, and so on. 

So, to locate the preference file for a given application, try each of these 
steps until you find it: 

1. Open ~/Library/Preferences and set the window to List View 
(View > As List). Click the Name column to sort the list by name. 

2. Scroll down to where the application’s name would be if it followed 
the reverse-URL format. Look for adjacent files, too, in case the 
application has more than one. 

3. Type a portion of the application’s name in the window’s Search 
field (for versions of Mac OS X that have one), or use Mac OS X’s 
Find command (File > Find). If that yields no results, repeat with 
a portion of the developer’s name. 

4. If you find more than one potential match, check the modification 
date. Usually the file or folder modified most recently is the one 
you’re looking for. 

5. If you still haven’t found the file(s), repeat Steps 1–3, but this time 
look in /Library/Preferences. 

Once you’ve located the file(s), then what? Well, you could drag them 
to the Trash, but I wouldn’t. If the file isn’t faulty after all, you may find 
yourself having to reset lots of preferences for no good reason. In some 
cases, that might mean digging out your license code and reentering 
your registration data. Instead, I suggest moving the file(s) temporarily 
to your Desktop. Follow these steps: 

1. If the application is running, quit it. 

2. Drag the preference file(s) to your Desktop. 

3. Open the application again. It creates a new, default preference file 
(or files) for itself. 

4. Test the application to see if the problem still exists. If not, the old 
preference file was probably at fault, so you can trash the one on 
your Desktop. If the problem is still there, the preference file was 
probably good—so you can quit the application and drag the file(s) 
from your Desktop back where they came from, replacing the 
preference file(s) created in Step 3. 
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Reset PMU, SMU, SMC, NVRAM, or PRAM
 

Every Mac has at least one chip that stores certain small bits of 
information even when the power is off. Depending on your Mac 
model, it may have a PMU (power management unit), SMU (system 
management unit), SMC (system management controller), NVRAM 
(non-volatile RAM), PRAM (parameter RAM), or some combination 
of these. Although it’s uncommon, any of this memory can become 
corrupted, leading to symptoms including problems turning on, 
sleeping, or waking up; excessive fan noise; not displaying video; and, 
for portables, not recognizing or charging a battery. 

In case you encounter such symptoms, I’d like to tell you how to reset 
these various sorts of memory, but the instructions vary significantly 
from one Mac model to the next. Also, in some cases a single technique 
can reset all the relevant chips, while in other cases you may have to 
follow one procedure for, say, the SMU and another to reset the PRAM. 
Instead of spending several pages laying out all the details, I’ve listed 
the pages on Apple’s Web sites that describe the reset procedures: 

•	 PRAM and NVRAM (all Macs): http://support.apple.com/kb/ 
HT1379 

•	 SMC (all Intel-based Macs): http://support.apple.com/kb/HT3964 

•	 PMU (Mac mini): http://support.apple.com/kb/HT2183 

•	 PMU (PowerBook or iBook): http://support.apple.com/kb/HT1431 

•	 SMU (iMac G5): http://support.apple.com/kb/HT1767 

•	 SMU (Power Mac G5): http://support.apple.com/kb/HT1436 

Use Activity Monitor
 

You may think that your Dock shows you all the applications that are 
currently running, but dozens or even hundreds of other background 
processes could be running too. Most of these are components of Mac 
OS X that use system resources only when needed and stay out of the 
way the rest of the time. But sometimes, a rogue program can start 
chewing up RAM or CPU cycles and not playing nice with others. If 
this happens, your whole computer can slow down. To find out what’s 
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happening behind the scenes, turn to Apple’s handy Activity Monitor, 
which you can find in /Applications/Utilities. 

Tip: I go into a great deal more detail about how to use Activity 
Monitor in Take Control of Speeding Up Your Mac. 

Activity Monitor can tell you all sorts of things about your CPU, RAM, 
Disk, and Network activity. But for troubleshooting purposes, I want 
to focus on just a couple of pieces of information. 

The default view in Activity Monitor (Figure 3) lists all your current 
processes; you can sort and filter these in various ways. I typically click 
the CPU column header to display processes in order of their CPU 
usage. (When the arrow in the header points down, the most CPU-
intensive tasks appear at the top; to change the sorting direction, click 
the header.) To see which processes are using the most RAM, click the 
Real Mem column header (labeled Real Memory or RSIZE in some 
versions of Mac OS X). Regardless of how you sort the display, it 
updates periodically. 

Figure 3: Among the many things Activity Monitor can show is which 
applications (even ones not normally visible) are using the most CPU 
power and RAM. 
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I should warn you not to jump to hasty conclusions based on what you 
see in this window. The fact that a process is using a lot of resources 
for a while isn’t necessarily a sign of a problem. But it can be useful 
for identifying certain issues. For example, if Safari is running in the 
background with a few tabs open and it’s still near the top of the list 
in CPU or RAM usage, that could mean you have encountered a bug. 
Close some tabs (or quit Safari and relaunch it) to free up those 
resources. 

This list can also help you figure out which background applications 
you may have installed and then forgotten about. If one of these is 
being a CPU hog, consider checking for an update or uninstalling it. 

You can quit processes from within Activity Monitor too. To do so, 
select a process and click the red Quit Process button in the toolbar. 
Then click Quit. (If that doesn’t stop the process, repeat the procedure, 
but click Force Quit.) If you’re not the process’s owner, Activity 
Monitor prompts you to enter an administrator password. 

Warning! Don’t quit processes that are owned by root (which 
could disable Mac OS X, requiring a restart), and don’t quit the 
WindowServer process (which will log you out immediately). You 
can tell which user owns a process by looking in the User column. 

Check Free Disk Space
 

Mac OS X needs plenty of room on your hard disk for things like 
virtual memory swap files and software updates, and all sorts of bad 
things can happen if you have too little: kernel panics, crashes, hangs, 
slowdowns, and so on. My rule of thumb for adequate breathing room 
is to make sure your free disk space is at least twice the amount of 
RAM you have installed. (Some people suggest leaving a certain 
percentage of your disk space, typically 10 percent, free, but this logic 
doesn’t scale well to very small or very large disks.) If necessary, delete 
unneeded files to free up extra space. 

44
 



              
   

             
            
        

   

    

  

  

 
 

  

       
         

              
       

         
      

If you’re at a loss to know which files you can safely delete, allow me 
to offer some suggestions: 

•	 Try any of several utilities that show you the size of each folder or 
file on your Mac, enabling you to quickly identify and delete large 
files you may not be aware of. For example: 

‣	 Daisy Disk: http://www.daisydiskapp.com/ ($19.95) 

‣	 Disk Inventory X: http://www.derlien.com/ (free) 

‣	 GrandPerspective: http://grandperspectiv.sourceforge.net/ 
(free) 

‣	 JDiskReport: http://www.jgoodies.com/freeware/jdiskreport/ 
(free) 

‣	 OmniDiskSweeper: http://www.omnigroup.com/applications/ 
omnidisksweeper/ (free) 

‣	 WhatSize: http://www.whatsizemac.com/ ($12.99) 

Although each of these utilities does things slightly differently, 
GrandPerspective (Figure 4) is typical, giving you not only a 
graphical overview of file sizes but also a list of all folder sizes and 
an overview of space usage by file type. 

Figure 4: When you can’t figure out where all those large files are 
on your disk, consult a utility such as GrandPerspective. 
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•	 Finding, and deleting, duplicate copies of files on your disk can 
sometimes free up a good bit of space with no downside at all. To 
locate duplicate files, you can use utilities such as these: 

‣	 Chipmunk: http://www.chipmunk-app.com/ ($17.95) 

‣	 Tidy Up: http://hyperbolicsoftware.com/TidyUp.html ($30) 

•	 Deleting caches is generally a safe choice, although it’s temporary 
and may slow down your Mac; see Clear Caches. 

•	 If you download stuff from the Web often, check your ~/Downloads 
folder to see if it contains anything you no longer need, such as 
installers for software you’ve already installed. By default, Safari 
uses your ~/Downloads folder for downloads, but you can check 
Safari’s current location for downloads by choosing Safari > 
Preferences, clicking the General icon, and looking in the Save 
Downloaded Files To pop-up menu. Other Web browsers may have 
different download folders; check their preferences for locations 
if you’re unsure. 

•	 Your ~/Documents folder probably contains some files you no longer 
need. Skim the contents of this folder and its subfolders, looking for 
documents you have no further use for, and drag them to the Trash. 

•	 Look in /Applications (and /Applications/Utilities) for any 
software that you’ve installed over the past year but never use. 
(Expired demo software, anyone?) While you’re at it, be sure to 
look through /Library, /Library/Application Support and ~/Library, 
as well as ~/Library/Application Support for folder names matching 
the applications you just removed, and delete them as well. Resist 
the temptation to delete Apple software that came with Mac OS X, 
though; you may need it later. 

If you find it too cumbersome to uninstall software manually like 
this, or if you’re concerned that you might miss some pieces, try an 
uninstaller utility, such as one of the following: 

‣	 Amnesia: http://koingosw.com/products/amnesia.php ($9.95) 

‣	 AppDelete: http://reggie.ashworth.googlepages.com/appdelete 
(free) 

‣	 AppZapper: http://www.appzapper.com/ ($12.95) 
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‣	 CleanApp: http://www.synium.de/products/cleanapp/ ($13) 

‣	 Hazel: http://www.noodlesoft.com/hazel.php ($21.95) 

‣	 Spring Cleaning: http://store.smithmicro.com/
 
ProductDetails.aspx?pid=12878 ($49.99)
 

‣	 Uninstaller: http://macmagna.com/ ($29) 

When you finish deleting files, don’t forget to empty your Trash 
(choose Finder > Empty Trash or press Command-Shift-Delete). Until 
you do so, your Mac won’t free up the disk space previously occupied 
by the files. 

Check Log Files
 

Many of the programs on your Mac continually record details about 
what they’re doing in log files. In particular, they tend to make log 
entries when they encounter errors or other unexpected situations. 
In addition, every time an application crashes, a system-wide process 
called CrashReporter records the details of that crash in its own log. 
Log files are therefore an excellent source of information about what 
might be causing whatever problem you’re experiencing. 

Log files tend to contain a lot of highly technical data that looks like 
gibberish to the uninitiated. This data is useful to programmers, 
though, and if you contact a company’s technical support department 
to report a bug, they may ask you to send them one of your log files 
to help determine what the problem was. However, even without 
understanding all the ins and outs of a program’s workings, taking 
a quick glance at its log files can sometimes give you hints you need 
to track down a problem. 

The easiest way to view log files is with a program in /Applications/ 
Utilities/ called Console. (It could just as easily be called “Log 
Viewer”—all it does is display logs.) When you open it, it displays one 
or more windows like the one shown in Figure 5. On the left, the 
window lists logs you can view; if this list isn’t showing, click the Show 
Log List button (labeled Logs in Tiger) in the toolbar. 
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Figure 5: It’s not pretty, but Console can help you figure out why 
something went wrong by showing the log files applications create. 

Console can show two particularly important log files: console.log 
and system.log. These two log files tend to contain the most interesting 
error messages generated by applications and Mac OS X itself. Some 
items may appear in just one of these logs or the other; some appear 
in both. But while system.log shows only messages generated since 
your last restart, console.log keeps a longer record. To display the 
contents of system.log, select it in the Log List on the left. To display 
the contents of console.log, choose File > Open Console Log or, in 
Tiger, select console.log in the Log List. 

So you’ve opened one of these logs, and you’re thinking: “I don’t have 
a clue what I’m looking at or how to find what I’m looking for.” It may 
take time and experience to get a feel for what’s truly helpful and what 
to do when you find it, but here are some tips to help you glean useful 
information: 

•	 Start at the end: The most recent information is at the bottom, 
and it’s updated in real time. So if you’ve just experienced a crash 
or other problem, information about it is likely to be near the 
bottom of one of the logs. 

•	 Filter: You can filter a log to display only the lines containing some 
string of text by typing in the Filter field in the toolbar. For example, 
if you type in error, Console displays only those lines with the word 
“error” in them somewhere. (And that is, in fact, a highly useful 
place to start. Another useful term to filter for is fail.) 
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•	 Repetition is significant. Repetition is significant: Pay 
special attention to lines that repeat many times. If you see the 
same (or similar) error message 50 times in a row, you know that 
an application is repeatedly trying and failing at some task. At the 
same time, some applications are simply chatty and fill logs with 
lots of messages that don’t indicate any problems. 

•	 Consult the oracle: If you see a phrase that suggests a problem 
but you don’t know what it means, try searching for it in Google, 
enclosed in quotation marks. For example, suppose you have a log 
entry that reads: 

Apr 25 19:19:03 MacBook-Pro /Library/PreferencePanes/ 
BusySync.prefPane/Contents/Resources/BusySync.app/Contents/ 
MacOS/BusySync[411]: Warning: accessing obsolete X509Anchors. 

You might try searching Google for "Warning: accessing obsolete 
X509Anchors" (again, remember the quotation marks), which may 
list developer documentation on what that phrase means or reports 
from other people who have seen that message in their logs and 
have theories as to its significance. 

•	 Go back further: You can also look at older copies of system.log 
by navigating in the Logs list to /var/log. 

•	 Cast a wider net: Although console.log and system.log are the two 
most useful log files, they don’t contain every log entry. Also look in 
other places in the Logs list, such as /Library/Logs and ~/Library/ 
Logs, for logs specific to a program. In addition, check in /Library/ 
Logs/CrashReporter and ~/Library/Logs/CrashReporter for an 
application’s crash logs. 

Clear Caches
 

Caches help applications load more quickly and run more efficiently 
by storing frequently used information. Usually, caches speed up your 
computer and are therefore good to keep around. However, in certain 
situations, a cache can cause problems rather than solving them. If a 
cache file becomes damaged, for example, an application may crash or 
otherwise misbehave when it reads in that file. Or, if a cache file grows 
excessively large, it may take longer to read it than it did to generate 
it in the first place. 
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Note: I discuss caches in detail in a Macworld article titled “34 
Software Speedups” (http://www.macworld.com/article/49489/). 

Most of your caches live in one of two places: either /Library/Caches 
or ~/Library/Caches. Any of these cache files can be deleted safely, 
because applications regenerate cache files automatically as needed. 
However, I recommend against wiping out caches indiscriminately, 
because intact caches (which will be most of them) do improve your 
computer’s performance. 

When a troubleshooting procedure calls for clearing caches, follow 
these steps: 

1. Make sure the application you’re troubleshooting is not running. 

2. Look for a file or folder containing the name of the offending 
application—look first in ~/Library/Caches and then in /Library/ 
Caches. If you find it, drag it to the Trash. (In some cases, you may 
have to enter your administrator password when dragging cached 
files to the Trash.) 

3. Reopen the application and see if the problem still exists. If not, 
you’re done. If it does, continue with… 

4. If you’re having trouble with a Microsoft Office application, 
consider deleting its font cache, which is stored separately from 
other caches. To clear it, quit all your Office applications, navigate 
to ~/Library/Preferences/Microsoft, and drag the appropriate file 
to the Trash: 

‣ For Office X: Office Font Cache (10) 

‣ For Office 2004: Office Font Cache (11) 

‣ For Office 2008: Office 2008/Office Font Cache (12) 

‣ For Office 2011: Office 2011/Office Font Cache 

Test to see if the problem has disappeared. If not… 
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5. Mac OS X maintains a system-level font cache that numerous 
applications use. Bad font cache files have been implicated in many 
problems. To delete most of your font caches manually, do this: 

‣	 10.5 Leopard or later: Open Terminal (in /Applications/ 
Utilities) and type atsutil databases -remove followed by 
Return. 

‣	 10.4 Tiger or earlier: Drag the /Library/Caches/com.Apple.ATS 
folder to the Trash. Enter your password when prompted to do 
so, and click OK. 

Then restart your computer and empty your Trash. However, be 
aware that when you do this in Leopard or later, any fonts you’ve 
disabled in Font Book will be re-enabled. If the problem still hasn’t 
gone away… 

6. Delete your other system-wide caches—everything else in /Library/ 
Caches—and restart your computer. Test once again to see if the 
problem is gone. If not… 

7. As a last resort, delete the caches in /System/Library/Caches. (You 
will again need to enter your administrator password to do so.) 
Restart your computer. 

Cache-Clearing Utilities 

Because dragging a folder to the Trash is easy and lets me control 
exactly what gets deleted, I prefer to clear my caches manually. 
However, numerous utilities, including the following, let you clear 
caches with just a couple of clicks (usually letting you choose which 
caches, and also letting you delete logs and other clutter): 

✦ Cocktail: http://www.maintain.se/cocktail/ ($14.95) 

✦ Snow Leopard Cache Cleaner: http://www.northernsoftworks.com/ 
snowleopardcachecleaner.html ($9.99) 

✦ MacCleanse: http://koingosw.com/products/maccleanse.php 
($19.95) 

✦ OnyX: http://www.titanium.free.fr/ (free) 

✦ Purity: http://purityapp.com/ (free) 

✦ Yasu (Yet Another System Utility): http://jimmitchell.org/yasu/ 
(free) 
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Check Your RAM
 

Mac OS X is picky about the quality of RAM in your computer. If it’s 
defective or even slightly out of spec, kernel panics or other crashes 
can result. RAM installed by Apple at the factory has a low incidence of 
failure, but if you’ve installed third-party RAM yourself (and especially 
if you used a cheaper brand), you’re at a greater risk for problems. 

Several utilities can check your RAM to make sure it’s healthy: 

•	 Apple Hardware Test: This one is not only free, it also came with 
your Mac (if you purchased it within the past several years). 
Depending on when you bought your computer, it could be on an 
independent disc, or it may be included on the Mac OS X Install 
media. (Look for tiny lettering on the media that says “To use Apple 
Hardware Test, hold down the Option key as the computer starts 
up,” or words to that effect—the key you’re asked to press varies.) 

•	 TechTool Pro: http://www.micromat.com/ ($99.99) 

•	 Rember: http://www.kelleycomputing.net/rember/ (free) 

If you use a third-party tool, follow the instructions that came with it. 

To run Apple Hardware Test, follow these steps: 

1. Insert the media with Apple Hardware Test on it into your Mac and 
restart, holding down the Option key until icons appear 
representing the available startup volumes. 

Apple knows best: If the disc label or other documentation 
specifies holding down a key other than Option, do what it says. 

2. Click the Apple Hardware Test icon, and then click the right arrow. 

3. After the program loads, select a language and click the right arrow. 

4. On the Hardware Tests tab, click Extended Test. 

5. Catch up on your gardening or read the newspaper—this test can be 
time-consuming! 
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The screen may say something like “Estimated time: 10–15 minutes, 
or longer depending on the amount of memory installed.” Take the 
“or longer” part seriously. On a test machine with only 2 GB of 
RAM, the test took almost an hour and 45 minutes. 

6. If all is well, the word “Passed” appears next to all the applicable 
tests in the Test Results area. If not, a failure message appears; if 
this happens, look in the About the Test and Results area for advice. 

7. Click Restart to restart your computer. 

If Apple Hardware Test (or another utility) reports that you have 
defective RAM, the module in question must be replaced. If the 
module was installed by Apple and your computer is still under 
warranty (or AppleCare), Apple should replace it at no charge. If 
you purchased your RAM from another vendor, check their warranty 
terms. (Several RAM vendors offer lifetime warranties.) 

Note: Even if your RAM passes all tests perfectly, it could be out of 
spec enough to cause problems. I mention an example ahead in Your 
Computer Keeps Turning Itself Off. 

Test for Reproducibility
 

You’ve heard the joke: “I said, ‘Doctor, it hurts when I do this.’ And he 
said, ‘Then don’t do that.’” But, of course, any doctor truly would want 
to know what makes a symptom worse (or better). If you can clearly 
describe the circumstances under which some problem reliably occurs, 
you’ll be that much closer to a diagnosis. It’s not terribly helpful to 
know that your arm hurts “sometimes” or that Safari crashes “now and 
then.” But if your arm hurts only when you hold it at a certain angle or 
Safari crashes only when you visit a certain Web site, then you’re on 
to something. 

Programmers love detailed reports about exactly how to reproduce 
a problem. If the programmers can get the problem to occur, they can 
usually fix it. If they can’t, they have to guess at the cause. If you report 
a bug to a software developer, giving information on reproducibility 
is important. But even if you’re just trying to work around it yourself, 
knowing where and when the problem occurs can help. 
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Testing for reproducibility isn’t as easy as it sounds, though, because 
sometimes problems seem to occur randomly or unpredictably. But 
you can get at least partway there with these suggestions: 

•	 Take notes: When you encounter a problem, immediately think 
about the two or three things you did most recently, and write them 
down. For example, if Mail crashes, you might make a note of the 
fact that you just checked your email, and before that you added a 
new rule, and before that you did a search for messages from your 
boss. If the problem happens repeatedly, these notes can help you 
find patterns. 

•	 Narrow the scope: Let’s say a problem occurs when you have 
a dozen applications running. Try quitting half of them and see if 
the problem still occurs. If it does, quit half of the ones remaining, 
and so on. Or, if a problem happens when you’re running Mac OS X 
normally, try a Safe Boot (see Start Up in Safe Mode). And if the 
problem goes away, try rebooting normally but disabling login items 
(see Turn Off Login Items). 

You’re trying to get the problem to occur under conditions as 
specific and repeatable as possible. To that end, it’s most helpful 
to change only one type of thing at a time. For example, if your Mac 
is doing something odd and you quit applications, reset your SMC, 
add RAM, and repair your disk before confirming that the problem 
has gone away, you’ll be unable to tell which of those procedures 
fixed it—and that can be quite important to know, especially if the 
problem happens again in the future. 

•	 Try other environments: If a problem occurs on your Mac, 
does it also happen on your spouse’s Mac? If your mouse is jittery 
when plugged into your keyboard’s USB port, is it also jittery when 
plugged directly into the computer’s USB port? If a document looks 
weird in Word, does it also look weird in TextEdit? Try to test 
whether your problem appears under a variety of circumstances. 

If you can get to the point where you can get a problem to occur 
intentionally—always and only when you’re trying to—you’re actually 
close to a solution. If the obvious remedies (such as disabling 
preference files and caches and starting up in Safe Mode) don’t work, 
you at least have solid information to provide to the developer’s tech 
support staff, which can help them to solve your problem. 
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Get System Information
 

Many of the troubleshooting steps you may take (such as searching 
for information on Apple’s Web site or contacting technical support) 
require that you know exactly which version of Mac OS X you’re 
running, among other details. If you don’t know which version of Mac 
OS X is installed, choose Apple  > About This Mac (Figure 6). 

Figure 6: Choose Apple  > About This Mac to display a window 
showing your Mac model, operating system version, and other 
details. 

When you’re talking to a developer’s technical support staff, they may 
ask you for more detailed information about your Mac, such as which 
extensions are installed and what brand of hard drive it has. To get this 
information, use an Apple utility called System Profiler. 

You can open System Profiler either by clicking the More Info button 
in the About This Mac window or by double-clicking the System 
Profiler icon found in /Applications/Utilities. At this point, 
a technician may ask you to look for, and read off, certain information 
found in the System Profiler window, or to save a file with all the 
details and send it in as an email attachment. To do this, as shown 
in Figure 7, choose File > Save, type a name, choose a location, and 
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leave File Format set to System Profiler 4.0 (XML) unless instructed 
otherwise. Click the Save button, and then attach the saved file to an 
email message. 

Figure 7: You can save the entire System Profiler report about your 
computer to send to a technical support representative. 

56
 



          
             

          
         

           
   

    

              
           

             
           

          
             

             
           

          
           

             
             
            

       

             
               
           

         
             

   

          
         

           
            

Solve Common Problems
 
Now that you have a collection of basic problem-solving techniques 
under your belt, it’s time to move on to specific problems. I realize 
that many problems you may encounter aren’t mentioned here (in 
which case, move on to Troubleshoot Novel Problems), but these 
are 15 of the most common Mac problems for which there’s a 
straightforward path to a solution. 

Your Computer Won’t Turn On
 

One day you sit down at your Mac and press the power button, but 
instead of the reassuring startup chime you hear nothing. No power 
light, a blank screen—no sign of life. This is an especially good time 
to remember not to panic. Take a deep breath and follow these steps: 

1. Check the entire electrical path. Start with the power cord where 
it connects to your Mac and make sure it’s firmly seated. Then make 
sure the other end is plugged in tightly. If you have anything else 
between the plug and the wall outlet—such as an outlet strip, surge 
protector, or UPS—check each of the plugs along the chain. Also, 
check for crimps or sharp angles in the cords, which could mean 
broken wires inside. If you find or suspect a broken wire, replace the 
cord. (If you were using a surge protector and there was a lightning 
strike or power surge, it may have sacrificed itself to protect your 
Mac. Be sure to check its failure indicator.) 

If all the connections look good, try plugging a lamp or other device 
into the same outlet as your Mac to verify that the juice is flowing. If 
not, check your building’s circuit breakers. If it still won’t turn on… 

2. Unplug everything from the computer except the keyboard, mouse, 
and display. Press the power key again. If it turns on, suspect a 
faulty peripheral. If not… 

3. Reset the PMU, SMU, or SMC (if appropriate). (See Reset PMU, 
SMU, SMC, NVRAM, or PRAM.) Obviously, you can’t perform a 
procedure that requires holding down keys while starting up if you 
can’t start up, but most of these resets can be done without power. 
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If none of these procedures brings your Mac back to life, it’s time to 
call a repairperson. See Go to the Source. 

Your Computer Keeps Turning Itself Off
 

Perhaps the problem isn’t that your Mac won’t turn on, but that it 
keeps turning itself off when you don’t want it to. This could signal 
a problem with your computer’s power supply, logic board, or RAM. 

However, before taking your computer in to the shop for a potentially 
expensive repair, try the following: 

•	 Check to see that the power cord is firmly seated (on both ends), 
and if your computer is plugged into an outlet strip, make sure 
that’s also plugged in securely. 

•	 If your computer is plugged into a UPS, make sure the UPS itself 
is working and that it can run the computer from battery. If not, a 
small power fluctuation could result in the computer losing power 
when you thought it was being protected by the UPS. 

•	 Carefully check the settings in the Energy Saver pane of System 
Preferences. In particular, click the Schedule button and verify that 
your computer is not set to shut down automatically. 

•	 Start Up in Safe Mode and run your computer for a while to see if 
the problem recurs. 

•	 Reset all the nonvolatile memory (read Reset PMU, SMU, SMC, 
NVRAM, or PRAM). 

•	 Check the RAM (see Check Your RAM). But note that sometimes 
even RAM that passes all tests with flying colors can lead to random 
shutdowns because of subtle variations from Apple’s specifications. 
For example, the late-2010 iMacs often exhibit this problem when 
outfitted with 16 GB of third-party RAM (lower amounts of RAM, 
and Apple’s factory-installed RAM, appear to be fine). I 
encountered this problem myself, and in my case, the solution was 
to replace the RAM with the same brand (Samsung) Apple uses. 

If your Mac continues to shut itself off or restart randomly, after trying 
all these suggestions, it’s time to take it in for repair. 
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You Experience Repeated Kernel Panics
 

When a single application crashes, it’s annoying but at least the rest 
of Mac OS X usually continues to function. But occasionally, you may 
find that your screen dims, your computer no longer responds to your 
keyboard or mouse, and a message like the one in Figure 8 appears 
on your screen. What has happened is known as a kernel panic—a type 
of low-level, system-wide crash that Mac OS X can’t recover from. 

Figure 8: This mysterious-looking message means you’ve just had a 
kernel panic. Follow the instructions, and then if it recurs, take steps 
to solve the underlying cause. 

A single isolated kernel panic is usually nothing to worry about. Follow 
the instructions: hold down the power key to turn off your Mac, turn 
it back on, and forget about it. However, if kernel panics happen often 
(say, more than once per week), something more serious may be afoot. 

Unlike application crashes, kernel panics tend to occur seemingly 
randomly, making them difficult to reproduce. It doesn’t usually make 
sense to try something, test whether the panic recurs, and then move 
on to the next step. Instead, start by doing all these things: 

•	 Check your disk space: A kernel panic could be a sign that you’re 
running low on free disk space. If necessary, delete unneeded files 
to free up extra space; see Check Free Disk Space for help. 

•	 Make sure your RAM is healthy: See Check Your RAM. 
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•	 Repair disk permissions: Read Repair Permissions. 

•	 Make sure your firmware is up to date: Apple provides 
complete details on how to find out whether firmware updates are 
available for your Mac, and how to download and install them if so. 
For Intel-based Macs, see http://support.apple.com/kb/ht1237; for 
PowerPC-based Macs, see http://support.apple.com/kb/ht1395. 

•	 Check for software updates: Any of the applications that were 
running when the kernel panic occurred may have bugs that 
resulted in the crash. Download and apply any available updates. 

•	 Check your logs for clues: When a kernel panic occurs, Mac 
OS X stores information about it in a log file. Even if you can’t make 
sense of all the details in this log file, glancing at it (especially the 
most recent portion before the panic) may give you a sense of which 
component(s) of your system may have either triggered, or been the 
victim of, the panic. Open Console (consult Check Log Files) and 
look for entries in: 

‣	 10.6 Snow Leopard and later: /Library/Logs/DiagnosticReports 

‣	 10.5 Leopard: /Library/Logs/PanicReporter 

‣	 10.4 Tiger and earlier: /Library/Logs/panic.log 

Video panic: A reader wrote to share the following anecdote: 
“Two friends, both with the 2010 MacBook Pros, had numerous 
kernel panics. The crash logs all indicated it was the Intel HD 
[Graphics] drivers in 10.6.5 and 10.6.6. They disabled ‘automatic 
graphics switching’ [in the Energy Saver pane of System 
Preferences] and have been fine ever since.” 

If you continue having kernel panics, try each of these steps in order: 

1.	 Unplug peripherals: If you have anything plugged into your Mac 
other than a keyboard, mouse or trackball, display, and Ethernet 
cable, unplug it. That includes any printers, scanners, PDAs, 
cameras, or other USB or FireWire devices. (If you have a spare 
keyboard and mouse, you might try those, too, since they could be 
part of the problem.) 
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Restart, and see if the kernel panic recurs. If not, add the devices 
back one at a time: 

a.	 If you find the one that causes the crash, check that you’re using 
the latest driver software; if so, contact the developer for help. 

b. If the panics continue with all devices unplugged, move on to… 

2.	 Check kernel extensions: Look in /System/Library/Extensions 
for any third-party items you may have added recently. This may 
include things like drivers for audio interfaces and input devices, 
security software, and certain system enhancements. If you find 
any, look for an uninstaller provided by the developer, and if there 
is one, use it. If not, consult the documentation that came with the 
software, or the developer’s Web site, for removal instructions. (I 
recommend against manually dragging these items to the Trash 
unless you can find no other way to remove them.) 

Restart and see if the problem goes away. If it does, reinstall the 
programs that use the kernel extensions one at a time, restarting 
after each one, until you find the culprit. If panics continue, then… 

3.	 Try a Safe Boot: Read Start Up in Safe Mode for instructions. 

‣	 If the problem goes away, look in the folders inside /Library and 
~/Library for files you’ve added recently. (To make this easier, 
choose View > As List and then click the Date Modified column 
to sort the folder’s contents by how recently they were changed.) 
Move them out temporarily, restart normally, and try again until 
you’ve narrowed down the cause. 

‣	 If the problem does not go away in Safe Mode, go to… 

4.	 Disable your login items: Perform the steps in Turn Off Login 
Items. If the panics disappear, open the Accounts pane of System 
Preferences (or, in Lion, Users & Groups), go to the Login Items 
view, and one by one, remove items in that list (starting at the end), 
by selecting them, clicking the minus button, and then logging 
out and back in. Stop when you’ve identified the problematic item. 

Log entry: If you’re unsure where a login item is located, then 
before you remove it, hover over it briefly to see its location in a 
yellow tooltip. Make a note of this so you can easily add it back 
later if it turns out not to be the problem. 
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If, after you’ve done all these things, the kernel panics continue, your 
only recourse may be to reinstall Mac OS X. See the sidebar “A Clean 
Start,” next, for specific advice. 

A Clean Start 

Reinstalling Mac OS X isn’t the quickest or easiest troubleshooting 
step, but it needn’t be painful either—as long as you do it the right 
way. When the time comes to reinstall, follow this procedure: 

1. Be sure you have at least one good bootable backup (and another 
current backup or two wouldn’t be overkill either). 

2. Using your Mac OS X Install media, run the installer. 

3. After clicking through the language selection screen, Choose 
Utilities > Disk Utility. In the list on the left, select the volume you 
want to erase. Volume names (there may be one or more per disk) 
are shown indented under the disk name, so be sure to select one 
of the indented icons. Click Erase, and confirm your selection. Quit 
Disk Utility, and continue running the installer. 

4. On the screen that asks you to choose a destination, select your 
former startup volume, and proceed with the installation. 

5. Near the end of the installation process, when you reach the 
screen in Setup Assistant that says “Do You Already Own a Mac?”, 
select the From Another Volume on This Mac radio button. Click 
Continue. 

6. If you have only one other volume available with Mac OS X 
installed, that volume appears at the top of the screen. If you 
have more than one volume, a pop-up menu displays your 
options; choose your bootable duplicate using that menu. 

7. Select all available items and click Transfer. 

Note: It’s possible, though not likely, that by selecting all the 
items here, you’ll put back whatever caused the kernel panic in 
the first place, thus causing it again! If that happens, start again, 
deselecting Applications. You’ll have to reinstall third-party 
applications, but the possibility of a crash decreases. 

The installer copies all the data from your bootable duplicate back to 
its original locations on your startup disk. 
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Your Mac Is Abnormally Slow
 

A single application running slowly is annoying, but when your entire 
Mac slows down, getting even simple tasks done can be an exercise in 
frustration. You can use any of numerous tactics to return your Mac to 
its usual peppy state. 

When I wrote the first edition of this book, I devoted a mere three 
pages to this topic as though it were a single, simple problem with a 
straightforward solution. In the years since, many experiences—with 
my own Macs and with those belonging to friends and family members 
—have persuaded me that Mac slowdowns are a vastly bigger problem 
that deserved to be taken much more seriously. As I started 
researching all the factors that might go into speeding up a Mac, I 
realized that I couldn’t possibly do justice to it in a few pages—it was 
enough material for its own book (in fact, one that’s nearly twice as 
long as this one)! 

I’ve now written that book: Take Control of Speeding Up Your Mac. 
If your Mac is too slow, that book is the place to find all your answers. 

However, I do want to offer a few brief words of advice, taken from 
a chapter in that book called “Try a Few Quick Fixes.” These constitute 
the barest tip of the iceberg; the remainder of that book covers many 
more performance issues—and is much more rigorous about 
performing tests to figure out exactly what the causes of slowdowns are 
and the extent to which various procedures improve your Mac’s speed. 
But, in the interest of offering something to get you started, here are 
compressed versions of that book’s quick fixes: 

1.	 Restart your Mac: After you do so, you may find that your Mac 
runs more slowly the longer you use it. If so, continue with one or 
more of the following steps. 

2.	 Quit inactive applications: You may want to keep some 
programs, like your email client, open all day. But anything that’s 
running in the background can drag your CPU down. Web browsers 
are notorious for doing this, especially when you have Web pages 
open that feature sound, animation, movies, or other elements that 
require a lot of processing. 
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3.	 Prune login items: Once you’ve quit some background 
applications, you need to make sure they don’t run automatically 
the next time you log in: Open the Accounts pane of System 
Preferences (the Users & Groups pane in Lion). Go to the Login 
Items view and locate any items in the list you don’t need to open 
when you log in. Select each one and click the minus button. 

Keeping it simple: Several other mechanisms exist to launch 
background processes, but for the sake of simplicity, I’m omitting 
them. Suffice it to say that if an application includes a problematic 
background process, uninstalling that entire application is usually 
the best and most reliable solution. 

4.	 Log out of other accounts: If you use Fast User Switching, other 
logged-in accounts may be draining system resources. Switch to 
another account using the Fast User Switching menu in the menu 
bar, log out, and repeat this with any additional accounts except 
your own. 

5.	 Upgrade your firmware: I covered this in You Experience 
Repeated Kernel Panics, earlier—it’s a quick, easy procedure that 
may or may not speed up your Mac, but can prevent problems that 
could lead to slow performance. 

6.	 Reset the SMC: I also covered this in Reset PMU, SMU, SMC, 
NVRAM, or PRAM; just note that in certain cases resetting the 
SMC can perk up an otherwise slow Mac. 

7.	 Update Mac OS X: At minimum, make sure that you’ve applied 
any free updates (using Mac OS X’s built-in Software Update 
mechanism), because minor updates always fix bugs and often 
improve performance. In most cases, it pays to install major, 
paid upgrades too—assuming you can afford it and your Mac is 
compatible with the new version of Mac OS X. 

8.	 Upgrade your RAM: If your Mac doesn’t already hold its 
maximum amount of RAM, consider adding more. Most new Macs 
come standard with 2–4 GB of RAM, and for users with very basic 
needs that’s often adequate, but adding more can have a huge 
impact in performance. This is even more true for older Macs that 
had less RAM to begin with. I suggest aiming for the 8–16 GB range 
if your Mac can accommodate it; if not, add as much as it will hold. 
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If you’ve done all these things and still find your Mac is slow, I urge 
you to consult Take Control of Speeding Up Your Mac for further 
advice. 

You Can’t Empty the Trash
 

Once in a while, you may choose Finder > Empty Trash and get an 
error message saying a file can’t be deleted. The error message may 
give several reasons for this, such as the file being in use, being locked, 
or having permissions that prevent you from deleting it: 

•	 If the error message states that the file is in use, restart and try 
deleting it again. 

•	 If the error message states that the file is locked, hold down the 
Option key while choosing Finder > Empty Trash. 

•	 If the error message states that you do not have permission to delete 
a file, or if you see no error message at all but the file won’t go away, 
follow these steps: 

1. Open Terminal (in /Applications/Utilities). 

2. Type this, and then press Return: 

cd ~/.Trash 

3. Type the following: 

sudo rm -R 

followed by a space (the space is very important). 

4. Open the Trash window, select everything inside it, and drag 
those selected items into the Terminal window. 

5. Press Return. 

6. Enter your administrator password when prompted. 

You can download numerous utilities that can force the Trash to 
empty, but in my opinion, this procedure is sufficiently simple that 
nearly anyone can do it—and it requires no extra software. 
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An Application Grinds to a Halt
 

At some point you’ve undoubtedly seen your mouse pointer turn into 
a spinning rainbow pinwheel as an application stops responding. 
Apple calls this the “spinning wait cursor,” but most Mac power users 
I know refer to it as the SPOD—the initials stand for “spinning pizza 
of death,” “spinning pinwheel of doom,” or any of several other clever 
variants—or the spinning beach ball pointer. It indicates that an 
application has become unresponsive for more than a few seconds. 
Most of the time, other software continues to function correctly, and 
your pointer appears as a SPOD only when it’s over one of the windows 
of the application that’s busy (or another of its elements, such as its 
menu bar or Dock icon). 

Applications can stop responding temporarily for many different 
reasons. Sometimes, for example, they’re working hard at a task and 
don’t even take a breath, as it were, for a considerable period of time. 
Or, you could be running low on free RAM, slowing your applications 
as they lean more heavily on virtual memory. An application could 
also, of course, have a bug that causes it to hang. Whatever the reason, 
the SPOD is annoying because it means you can’t do anything with that 
application until it goes away. 

When you encounter the SPOD, follow these steps: 

1.	 Wait: More often than not, the SPOD goes away on its own—after 
a few seconds or, occasionally, as long as a few minutes. If the 
problem resolves itself and doesn’t return, you don’t need to do 
anything else. 

2.	 Quit other applications: If you have many applications open at 
once, they can use up such a large proportion of your Mac’s memory 
and CPU cycles that the application you’re actively using doesn’t 
have enough breathing room. So quit applications you aren’t 
actively using, or at least close extra windows (including open 
windows in the Finder) to free up extra resources. To see a list of 
applications and background programs that don’t show in the Dock, 
Use Activity Monitor. 

3.	 Force-quit: After 2 minutes or so of waiting—especially if you’ve 
quit as many other applications and closed as many windows as you 
can—you can be fairly confident that the program with the SPOD 
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isn’t going to come back to life. Your best bet is to force-quit it; see 
Force-Quit an Application for details. (Note that in so doing, you’ll 
lose any unsaved work, but you may not have any choice.) 

4.	 Restart: As I’ve said elsewhere in this book, restarting clears up a 
lot of common complaints. If a relaunched application hangs again, 
try restarting (see Restart Your Mac). 

5.	 Check your disk space: If an application continues to run slowly 
even after your restart, make sure you’re not running low on free 
disk space. Learn more in Check Free Disk Space. 

6.	 See if you have a damaged preference file: For instructions, 
read Check Preference Files. 

7.	 Check for software updates: If the application was running 
slowly due to a bug, it may have been fixed in a more recent version. 
Download and apply any available updates. 

8.	 Try more RAM: If you run lots of software at once, or if you 
run just one or two programs with voracious RAM appetites (I’m 
thinking of software such as Photoshop and Final Cut Pro), you will 
likely find that your computer runs rather slowly if it has only 1 or 
2 GB of RAM. 

Depending on your computer’s RAM capacity and your budget,
 
I recommend having at least 4–8 GB of RAM. More is even better,
 
up to a point—unless you’re doing extremely high-end video or
 
graphics work, you’ll probably find that the cost-to-benefit ratio
 
of more RAM becomes excessive after about 16 GB.
 

9.	 Contact the developer: When none of these steps solves the 
problem, contact the developer’s technical support department. 
They may know what the problem is, or be able to suggest more 
concrete next steps. 

You can find much more advice for dealing with the nefarious SPOD 
in Take Control of Speeding Up Your Mac. 
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Looking for Signs of Life 

When an application stops responding, it could be because Mac OS X 
itself has seized up. When this happens, you’ll be unable to switch to 
other applications (even to quit them), force-quitting may not work, 
and you may even lose keyboard and mouse control; performing 
a brute-force restart with the power button is usually the only cure. 
However, those symptoms could also mean than that an application 
is monopolizing your processor temporarily. How can you tell the 
difference? 

The key is to take steps before your computer hangs to provide clues 
as to its activity level. You can do this in either of two ways (but I do 
both, for extra information): 

✦	 Open the Date & Time pane of System Preferences. In the Clock 
view, make sure Digital is selected, and check the Display the 
Time with Seconds box. 

✦	 Later, if a freeze occurs, look at the clock in your menu bar. If the 
seconds display doesn’t change—and remains stuck for more than 
a minute or two—your computer is unlikely to return to operation 
on its own. Restart it manually. 

✦	 Download the free MenuMeters utility from Raging Menace (http:// 
www.ragingmenace.com/software/menumeters/), and install its 
included preference pane. In the CPU view of this pane, check the 
Display CPU Menu Meter box and choose a style for your CPU 
meter (my favorite is Percentage and Thermometer, which looks 
something like this in your menu bar; if your computer has 
more than one processor or core, each one gets its own meter). 

When your Mac appears to hang, check the CPU meter. If the value 
changes over a period of a minute or two, your Mac is simply busy, 
so I suggest continuing to wait for a while. If it’s stuck—especially 
at something less than 100%—for more than a few minutes, restart 
your Mac manually. 

68
 

http://www.ragingmenace.com/software/menumeters/
http://www.ragingmenace.com/software/menumeters/
http://www.ragingmenace.com/software/menumeters/
http://www.ragingmenace.com/software/menumeters/


  

          
             
         

           
     

        
      

   

            
            

           
    

           
             
     

             
          

              
            

             
        

          
           
            

            

An Application Crashes
 

When an application crashes in Mac OS X, it usually disappears 
without warning. A few seconds later, a dialog like the one shown in 
Figure 9 appears. Translation: Something went wrong. We don’t 
know what. You can launch the application again and keep your fingers 
crossed that it won’t happen again. 

Figure 9: The first time an application crashes, a dialog like this 
usually appears. Click Relaunch to launch it again. 

Exceptions to the rule: A few applications, notably Microsoft 
Office, have their own mechanisms for reopening after crashes and 
may not display this dialog. If you experience a crash without this 
type of dialog, move on directly to Step 2 in the directions below. 

When an application crashes, try each of these steps in sequence until 
the application runs without crashing: 

1.	 Click Relaunch (or, in some versions of Mac OS X, click 
Reopen): Often, clicking this button is all you need to do and your 
application works properly from then on. 

If you were to click the Report button instead, you could send a 
report to Apple with details about what went wrong. But chances 
are slim that you’ll be the only one to report this problem, and that 
your report alone will enable Apple to solve it. (Moreover, the only 
problems Apple is likely to be able to solve are those in Apple 
applications; the Report button doesn’t send information to third-
party developers.) Even if that happens, though, an update may not 
appear for a long time. My advice: unless this problem recurs 
several times, don’t bother clicking Report. You want to get back to 
work now, not hold out hope for a solution months in the future. 
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Try, try again? If the application crashes again after clicking 
Relaunch (or Reopen), you can keep trying, but success is unlikely. 
Some versions of Mac OS X give you the option to reset the 
application’s preference file after your second relaunch attempt, 
but because this feature doesn’t work consistently, it’s better to do 
this manually, as described in the next step. 

2.	 Restart: As usual, restarting often cures what ails your Mac. Be 
sure to launch the application in question right after you restart 
and check to see if it runs correctly. 

3.	 Try another document: Sometimes a damaged document 
can cause an application to crash. To check this, open a different 
document than the one you were working on, or create a new one. 

4.	 Check your preferences: Sometimes a damaged preference 
file can result in an application crash. So follow the procedures in 
Check Preference Files, earlier, to check or reset the application’s 
preferences. If you rule out a bad preference file as the cause of 
the misbehavior, continue with the next step. 

5.	 Update your software: Make sure you’re running the latest 
version of the software that’s crashing. The developer may have 
fixed the bug that caused your problem. 

6.	 Repair disk permissions: Still no luck? Repairing disk 
permissions is worth a try, particularly if the application in question 
is from Apple. See Repair Permissions. 

7.	 Log in as a different user: Log out (choose Apple  > Log Out 
User-Name) and log back in again using your test user account (see 
Set Up Another User Account). If the application no longer crashes, 
it means something in your home folder was causing the problem. 

Back in your regular account, look through the folders in ~/Library 
(especially in ~/Library/Application Support) and in the Login 
Items view of the Accounts System Preferences pane and remove 
any files you may have added or updated recently. One of those is 
very likely the culprit. 

8.	 Try a Safe Boot: Read Start Up in Safe Mode for details. If 
rebooting in Safe Mode solves the problem, you know that some 
system-level program is at fault or that one of the caches disabled 
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by Safe Mode was corrupted. So first, try restarting normally and 
see if the problem is gone. If not, look inside the folders in /Library, 
particularly the Extensions and StartupItems folders, for anything 
that’s been added recently. Move any suspicious files to your 
Desktop, restart normally again, and relaunch the application. 

9.	 Run a disk-repair utility: See Run Disk-Repair Utilities. All 
sorts of random disk errors can lead to application crashes. 

10. Reinstall the software: If the application still crashes, there’s 
a chance—albeit a remote one—that the application itself, or one 
of its support files, is damaged in such a way that only reinstalling 
it can help. So you can try deleting it completely, including its 
preference file and any components it may have placed in /Library/ 
Application Support or ~/Library/Application Support. Then 
reinstall it from the original disc or a new download. After doing 
so, check for, and install, any available updates to the newly 
reinstalled software. 

Uninstall easily: It can be difficult to find all the components 
that an application has spread all over your disk, but numerous 
uninstaller utilities exist that can simplify the task. I discuss these 
in Take Control of Maintaining Your Mac. 

11.	 Check your logs: If you’ve gotten this far and the application is 
still crashing, be sure to look at your logs for clues (see Check Log 
Files). If they don’t point to any causes you can discern, contact the 
developer’s technical support department. 

12. Check your backup: Try restarting from your bootable duplicate 
and running the application. If it works correctly, consider cloning 
your backup disk back onto your startup disk. If your latest backup 
wasn’t extremely recent, you may need to exercise caution to avoid 
overwriting newer files that you still want to keep. But this is still 
faster and easier than the final option… 

13. Reinstall Mac OS X: This is the most extreme step, but when 
all else has failed, that’s what you need to do. Check the sidebar 
A Clean Start, earlier, for more details. 
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The Keyboard or Mouse Doesn’t Work
 

Few Mac problems are more frustrating than an unresponsive input 
device, because it can prevent you from performing the usual 
troubleshooting tricks you’d normally use! If your keyboard or mouse 
stops working—or if your mouse pointer moves but clicks don’t register 
—you can typically resolve the problem in one of several ways. 

Wired Devices 
If your input device is connected via a USB cable (look for a USB logo 
on the cable or next to the port on the computer), follow these steps: 

1. Unplug the device, wait 10 seconds, and plug it in. If it still doesn’t 
work… 

2. Plug it into a different USB port (preferably one built into the 
computer itself, rather than a keyboard or hub). 

Everybody needs a hub: If your input device is normally 
plugged into a hub, and Step 2 resolves the problem, the hub could 
be at fault. If it has a power adapter, make sure that it’s plugged 
in securely (on both ends). Try unplugging the hub from both the 
computer and AC power and reattaching it, then reattaching your 
input device to the hub. If it still doesn’t work, suspect the hub; they 
really do go bad sometimes and need to be replaced. 

If moving the device to a different USB port doesn’t bring it back 
to life… 

3. Restart. Noticing a trend here? Restarting cures many ills. (And 
remember, as discussed in Restart Your Mac, you can do so using 
the keyboard alone if your mouse isn’t working, and using the 
power switch alone if neither keyboard nor mouse is working.) 

A mouse of a different color? If you’re using a third-party 
input device that comes with its own software (I’m thinking of 
brands like Kensington, Logitech, and Microsoft), or if you’re using 
a utility to modify your input device’s behavior (such as USB 
Overdrive), and if nothing else has worked so far, this is a good 
time to check for an update to your mouse or keyboard software. 

72
 



    

          
         

           
            

         

                
           

         

              
         

         
     

         
            
              

            
         

             
      

         
           

          
           

         

           
            

          
     

                
           

If it still doesn’t work…
 

4. Unplug any other USB peripherals that may be connected, and 
restart again. If it still shows no sign of life… 

5. If possible, verify that the input device works on another computer. 
If it doesn’t, the device may be broken; contact the input device 
manufacturer for assistance. If the device appears to be functional… 

6. If you have a spare input device, plug it in and use it. If even that 
doesn’t work, your Mac may require service (see Go to the Source). 

Bluetooth Devices 
If your Bluetooth mouse or keyboard isn’t responding, follow these 
steps: 

1. Make sure the device is turned on. For good measure, turn it off and 
back on again—if it’s somehow stuck, this may unstick it. 

2. Temporarily turn off any other Bluetooth devices within a 10-meter 
radius; they could be causing interference. 

3. Check your Bluetooth adapter, if you’re using an older Mac with 
an external USB dongle for Bluetooth. Unplug it and plug it back 
in. Try the input device again. If that doesn’t work, move it to a 
different USB port and try again. (Be aware that moving the adapter 
to a different port may require re-pairing; see Step 5.) 

4. Check your device’s batteries. If the battery level is low, or if you’re 
not sure, recharge or replace the batteries. 

5. Re-pair the device. Choose Set Up Bluetooth Device from the 
Bluetooth menu, and follow the prompts. (If that menu isn’t 
in your menu bar, open the Bluetooth pane of System Preferences 
and check the Show Bluetooth Status in the Menu Bar box. Prior 
to 10.5 Leopard, this checkbox is in the Settings view.) 

6. If possible, verify that the input device works on another computer. 
If it doesn’t, the device may be broken; contact the input device 
manufacturer for assistance. If the device appears to be functional, 
move on to the last step. 

7. If you have a spare USB input device, plug it in and use it. Then visit 
or call a repair facility for assistance (see Go to the Source). 
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You Lose Your Internet Connection
 

Not all that many years ago, connecting to the Internet was a special 
activity that most of us did on occasion by using a modem and a dial-
up account. Nowadays, although dial-up access has its place, most Mac 
users have a high-speed, always-on connection of one sort or another— 
typically via DSL, a cable modem, or a satellite link. And an increasing 
number of applications, from search tools to backup software, assume 
that your Internet connection is always available. So if your connection 
suddenly goes down, getting even basic work done may be difficult— 
and some applications may refuse to run at all. 

If you’re setting up a new DSL, cable modem, or satellite connection, 
your Internet service provider is the best source of help. And, if you’ve 
just installed a new router or AirPort base station, look at the included 
instructions for troubleshooting tips. But if your connection was 
working fine, and it disappears without your having done anything 
different, follow these steps: 

1.	 Check your Web browser: If you notice an Internet outage 
while in a Web browser, try a different one. (Safari, for example, 
may lose its connection even though other browsers work well.) 
And if you notice it in an email client or other program, open a 
browser. Try visiting a few Web sites that are normally reliable 
(such as http://www.apple.com/, http://www.google.com/, and 
http://www.amazon.com/). 

If some sites respond but not others, it could indicate a Web server 
failure or a routing somewhere on the Internet—either one is likely 
intermittent. (You can use the Down For Everyone Or Just Me site 
at http://www.downforeveryoneorjustme.com/ to check if the 
problem is related to your location on the Internet.) If no sites 
respond in any browser, continue to… 

Shortcut: If your browser displays a button that says Network 
Diagnostics, click it and follow the prompts. Alternatively, in 
Leopard or later, you can run the Network Diagnostics utility 
manually by opening the Network pane of System Preferences, 
clicking Assist Me, and then clicking Diagnostics. This tool 
effectively automates Steps 2 and 3, which you can then skip. 
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2.	 Check your Ethernet or AirPort connection: 

‣	 If your computer connects to a router, switch, or modem using 
Ethernet, check the cable connections at both ends; you could 
even try a different cable if you have one. If the cable appears 
to be working, move on to Step 3. 

‣	 If you connect to the Internet wirelessly, make sure the 
connection is still active by checking the AirPort menu in your 
menu bar. (If that menu is absent, open the Network pane of 
System Preferences and check the Show AirPort Status in Menu 
Bar checkbox.) Even if it is active, you might try choosing Turn 
AirPort Off, waiting a few seconds, and then choosing Turn 
AirPort On again—occasionally this can jog an unresponsive 
connection back to life. 

If the connection is not active, verify that you’re using a network 
for which you have access privileges, and that the Signal Level is 
consistently above one bar. If all that checks out and you still 
have no Internet access, move on to… 

3.	 Check for a self-assigned IP address: If your Mac uses 
dynamic IP addressing (as many do) and it’s unable to get an IP 
address from your router or your ISP, it will assign itself an address 
beginning with 169.254. When that happens, you won’t be able to 
connect to any computers outside your local network. 

To check, open the Network pane of System Preferences and, 
in versions of Mac OS X prior to Leopard, choose your current 
connection from the Show pop-up menu (in Leopard and later 
your current connection should be pre-selected at the left). Then: 

‣	 If the IP address begins with 169.254, it’s self-assigned. To
 
request a new IP address:
 

‣	 In Leopard or later, click Advanced, click TCP/IP, and then 
click the Renew DHCP Lease button. 

‣	 In versions of Mac OS X prior to Leopard, click the Renew 
DHCP Lease button in the main portion of the Network 
preference pane. 

Then wait a few seconds. If you get a new, router-assigned IP 
address, check your browser to see if your connection is live. 
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Tip: Anecdotal reports suggest that turning AirPort off (choose Turn 
AirPort Off from the AirPort menu), waiting about 30 seconds, and 
turning it back on, can sometimes jog a connection back to life that 
doesn’t respond to the above procedure. 

‣	 If your IP address isn’t self-assigned, or if trying to get a new 
address doesn’t help, your next step is to… 

4.	 Reset your router or base station: Whatever equipment is 
between your computer and your outside Internet connection— 
which may include your DSL or cable modem, AirPort base station 
or third-party wireless access point, or other routers, or switches— 
should be reset. Power it off (or, if it has no power switch, unplug 
it). Wait 10 seconds, and power it back on. If you have more than 
one such device, do this for all of them, powering them back on in 
order of closeness to the Internet (the cable modem, then your 
AirPort Extreme Base Station, then your Ethernet switch, etc.). 
Make sure each device has booted completely before powering up 
the next one. 

Once everything has reconnected, try accessing a Web page again. 
If you still can’t, go to… 

5.	 Restart your computer: After restarting, check a Web site or two 
to confirm that your connection is restored. If not, continue with… 

6.	 Try another computer: If you have more than one computer 
using the same Internet connection, see if another computer can 
connect. If not, skip the next two steps and contact your ISP for 
help. But if the other computer can connect, your Internet 
connection itself is working, so proceed to… 

7.	 Check your DNS settings: Sometimes your Internet Service 
Provider doesn’t specify the addresses for DNS (Domain Name 
System) servers, instead supplying them to your computer 
dynamically. If their default DNS servers aren’t responding for any 
reason—or if the addresses for those servers don’t get through to 
your Mac—you might not be able to reach any other computers on 
the Internet. 
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You can test if your DNS settings are causing problems by entering 
the IP address for a Web site in your browser. For example, enter 
http://184.106.219.205 to go to tidbits.com: 

‣	 If you get an error message, proceed to the next step. 

‣	 If Apple’s Web page does appear, you know that DNS settings 
are at fault. So open the Network pane of System Preferences. 
In Leopard or later, select your current network connection in 
the list on the left. Click Advanced and then click DNS. In Tiger 
or earlier, choose your current connection from the Show pop-up 
menu and then click TCP/IP. 

In the DNS Server(s) field, you should have one or more IP 
addresses entered. If not, and if your ISP supplied you with 
addresses for their DNS servers, enter them now. Otherwise, 
enter these two addresses (one on each line), which point your 
computer to OpenDNS, a free DNS service: 208.67.222.220 and 
208.67.222.222. Click OK (if applicable) and then Apply or Apply 
Now (depending on your version of Mac OS X) and try 
connecting again. If that doesn’t work… 

8.	 Try a ping test: When you ping another computer, you send it a 
“packet”—a tiny message to say, essentially, “Is anyone there?” If 
you get no response, it means either that computer isn’t functioning 
or your Internet connection is dead; if you get a slow response, it 
can mean hardware problems at your ISP (among other things). 

To do a ping test, open Network Utility (in /Applications/Utilities) 
and click on the Ping button at the top. Enter 17.112.152.32 (the IP 
address for www.apple.com) in the address field, make sure Send 
Only 10 Pings is selected, and click Ping. You should see a series of 
messages as shown in Figure 10. 
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Figure 10: Using Network Utility’s ping feature can help you tell 
whether your Internet connection is healthy, flaky, or nonexistent. 

If all the packets sent were received (0% packet loss) and the whole 
process took less than 30 seconds or so, then your Internet connection 
is working. If the summary line near the end says that none of the 
packets was received (100% packet loss), your Internet connection is 
down. If only some of the packets weren’t received, or if completion of 
the test required several minutes or more, the slowdown is most likely 
with your ISP or other Internet routing equipment. 

If all these steps fail, contact your ISP for assistance. 

Printing Doesn’t Work
 

Printing is a hugely complex topic. Because printers fall into so many 
categories, and can be connected in so many ways, lots of things can 
cause printing problems. So I want to concentrate on a few of the most 
likely causes and solutions to printing problems. In this section, I 
assume that your printer was previously working fine with your Mac, 
and that it has suddenly stopped printing entirely. 
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(If it prints, but the printout is distorted or otherwise incorrect—or if it 
never printed in the first place—consult the documentation that came 
with your printer and consider contacting the printer manufacturer’s 
tech support. If you’re seeing incorrect fonts on printed pages, consult 
Sharon Zardetto’s Take Control of Font Problems in Leopard.) 

When nothing comes out of your printer—not just one document, but 
nothing from at least two different programs—follow these steps: 

1. Make sure your printer is plugged in. While you’re at it, check the 
cable connecting it to your computer (or your router or AirPort base 
station), if it has one. 

2. If your printer’s icon is already showing in the Dock, click it. If not, 
then: 

‣	 In Leopard or later, open the Print & Fax pane of System 
Preferences, select your printer on the left, and click Open Print 
Queue. 

‣	 In Tiger or earlier, open Printer Setup Utility (in /Applications/ 
Utilities) and double-click your printer’s name to open the 
printer’s window. 

If there’s a button in that window’s toolbar labeled Resume Printer 
or Start Jobs, click it. (Ordinarily, when the queue is running, it’s 
labeled Pause Printer or Stop Jobs.) Also, if there’s a job in the list 
with a status of Hold, select it and click Resume. If nothing prints… 

3. Select any print jobs in the list, click Delete, and then try printing 
again. 

4. Turn your printer off, wait a few seconds, and turn it back on. Try 
printing. If that doesn’t work… 

5. If your printer is connected to a router, AirPort base station, or any 
other intermediate device, turn off that device, wait a few seconds, 
and turn it back on. Try printing. If that doesn’t work… 

6. In Leopard or later, go back to the Print & Fax pane of System 
Preferences (Print & Scan in Lion); or, in Tiger or earlier, go back 
to Printer Setup Utility. Select your printer and click the minus 
button (Leopard or later) or Delete (Tiger or earlier). Then click 
plus or Add, and follow the prompts to set it up again. Try
 
printing. If that doesn’t work…
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7. If you have another Mac, see if you can print to this printer from 
it. If you can, you know the problem is with your computer and not 
your printer. So, double-check your cabling or other networking 
connection to the printer and proceed to… 

8. Try Print Therapy. This utility from Fixamac (http:// 
www.fixamacsoftware.com/software/), which you can try for free 
for 7 days, is available in versions for each major revision of Mac 
OS X. (The price varies according to the version of Mac OS X you’re 
using—newer versions are more expensive.) It can fix a wide range 
of printing problems. Follow the included instructions; you can try 
each of several successively more drastic repair procedures until 
you find one that works. 

If none of these procedures gets your printer working again, contact a 
consultant or repair shop for assistance (see Find a Consultant and Go 
to the Source). 

Spotlight Searches Fail
 

If Spotlight searches fail blatantly (such as no results appearing for 
a very common term), you can try any of several repair techniques, 
depending on the scope of the problem. 

Searching Is Broken in Apple Mail 
In Apple Mail, when you search only message headers (To, From, 
or Subject), Mail gets its results from its own index, whereas when 
you search message content, Mail relies on the system-wide Spotlight 
index. For whatever reason, Spotlight seems to fail within Mail more 
frequently than it does elsewhere. That’s why you may sometimes 
encounter a situation in which the Entire Message button is disabled 
when you search in Mail, but searching in headers still works. 

If that happens—or if searches yield no results when you can clearly 
see there are messages with matching content—try each of these steps, 
in order, until the problem goes away: 

1. Make sure that neither the folder ~/Library/Mail nor any of its 
parent folders is in Spotlight’s Privacy list (in the Privacy view of 
the Spotlight pane in System Preferences). 
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2. If you’re searching mailboxes in an IMAP or MobileMe account, 
be aware that Spotlight indexes only downloaded messages. So go 
to the Advanced view of Mail’s Accounts preference pane for this 
account and make sure the Keep Copies of Messages for Offline 
Viewing pop-up menu is set to either All Messages and Their 
Attachments or All Messages, but Omit Attachments. 

3. Regardless of the setting in Step 1, you may have mailboxes 
whose contents have not yet been downloaded to your computer. 
To ensure that they have been, choose Mailbox > Synchronize > 
Account-Name. (This may take some time.) 

4. Open Terminal (in /Applications/Utilities) and enter the 
following command, followed by Return, to re-import your Mail 
messages into the Spotlight index: 

mdimport -r /System/Library/Spotlight/Mail.mdimporter 

If that doesn’t solve the problem, skip ahead to Spotlight Indexes Are 
Damaged to learn how to rebuild your entire Spotlight index. 

Tip: For additional Mail troubleshooting tips, see Apple Mail Fails to 
Connect, ahead. 

Spotlight Fails on Certain Document Types 
Spotlight relies on a series of special importer files that tell it how to 
index the contents of various kinds of documents. For example, Mail 
has its own importer (mentioned just previously), and there’s one each 
for PDF, Rich Text, Microsoft Office, and numerous other document 
types. Third-party applications sometimes include their own importers 
to supplement those supplied as part of Mac OS X. If searches for a 
certain document type fail, the first thing to try is to ask Spotlight to 
re-import all (and only) the documents of that type. 

The way to do this is to open Terminal (in /Applications/Utilities) 
and enter mdimport -r followed by the full path to the importer 
in question. Those importers can be found in /System/Library/ 
Spotlight, /Library/Spotlight, or ~/Library/Spotlight. (Feel free to 
peruse those folders to see what’s there—it varies from one computer 
to another, depending on the version of Mac OS X you’re using and 
which third-party software you’ve installed.) 
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Here are some examples of what you might enter in Terminal:
 

•	 iWork: mdimport -r /Library/Spotlight/iWork.mdimporter 

•	 MailTags: mdimport -r ~/Library/Spotlight/MailTags.mdimporter 

•	 Microsoft Office: mdimport -r /Library/Spotlight/Microsoft\ 
Office.mdimporter 

•	 PDF: mdimport -r /System/Library/Spotlight/PDF.mdimporter 

If the problem still exists, move on to the next possibility: rebuilding 
Spotlight indexes from scratch. 

Spotlight Indexes Are Damaged 
When Spotlight gets fundamentally confused and its system-wide 
index is out of whack, you can tell it to start over—that is, trash your 
entire Spotlight index and allow Spotlight to rebuild it from scratch. 
The rebuilding process goes on in the background, but it may take 
several hours. It will also likely slow down your Mac while it’s working, 
so it’s best to do this before bed or sometime when you won’t be using 
the Mac. Follow these steps: 

1. Open Terminal (in /Applications/Utilities) and enter the 
following: 

sudo mdutil -E / 

2. Press Return and enter your password when prompted. 

When your Mac finishes rebuilding the Spotlight indexes, searching 
should work once again. 

Keychain (Seemingly) Forgets Passwords 

Mac OS X’s keychain stores user names and passwords for a long 
list f network services, including those from your email accounts in 
Apple Mail and Web-based forms that you can optionally store while 
browsing the Web with Safari. If your keychain file becomes damaged 
for any reason, a variety of symptoms can result, such as a failure to 
connect to a wireless network, a file or mail server, or MobileMe, even 
though the passwords are stored in your keychain and you’ve 
connected successfully in the past. 

82
 



           
          

    

      

       

    

 

            
             

           
         

            
           

    

           
              

           
            

             
          

            
        

          
          

           
               

           
          

If you suspect a keychain problem, using Keychain First Aid—a feature 
built into the Keychain Access utility—is a good first troubleshooting 
step: 

1. Open Keychain Access (in /Applications/Utilities). 

2. Choose Keychain Access > Keychain First Aid. 

3. Enter your keychain password in the Password field. 

4. Select the Repair radio button. 

5. Click Start. 

Keychain First Aid scans, and attempts to repair, all your keychains. The 
bottom part of the window displays the log (a series of messages about 
the repair process), noting any errors that were resolved—but most errors 
cause no problems for users, so don’t worry about them. 

If your keychain still doesn’t work, I suggest restoring it from your 
backup. (The keychain files you want to restore are located in ~/Library/ 
Keychains.) 

Apple Mail Fails to Connect
 

Apple Mail is a powerful and capable email client—and still, after 
all these years, my favorite of the many I’ve used. But it does have 
a reputation for failing to connect properly to receive or send email— 
seemingly at random times and for no apparent reason. If this happens 
to you, several remedies are possible. Try them in order until you get 
things working again. (This information was adapted from my book 
Take Control of Apple Mail in Snow Leopard, which has a lot more 
information about using Apple Mail and fixing its problems.) 

Check Connection Doctor 
To open Connection Doctor, choose Window > Connection Doctor. In 
the Connection Doctor window, Mail lists every incoming and outgoing 
email account you’ve configured. It attempts to log in to each account, 
and if it fails with any of them, it shows an explanation of why it failed. 
These explanations aren’t always helpful, but they often give you a 
good starting point in debugging problems, and are written in 
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refreshingly plain English. If the Connection Doctor window suggests 
a specific fix, try that first. Otherwise, proceed with the following steps. 

Fix Incoming Mail Problems 
If Mail cannot download incoming messages, the cause may be 
anything from an incorrect setting in Mail, to a server problem, to 
a loss of Internet connectivity. Work through each of the following 
sections until you resolve the problem. 

Tip: To check on what Mail is doing behind the scenes, choose 
Window > Activity Viewer. A small floating window appears, 
displaying detail about each activity Mail is performing. To cancel 
any task, click the red “Stop” button next to it. 

User Name and Password Errors 
Sometimes, even after successfully checking your email many times 
with the password you entered when setting up an account, Mail 
displays a dialog claiming that the mail server has “rejected” your 
password. Worse, you may re-enter your password—and even select 
Remember This Password in My Keychain—but find that another error 
message pops up as soon as you click OK. This annoyance may be due 
to any number of causes, but most have simple solutions. 

If Mail suddenly begins prompting you for your password repeatedly 
when checking incoming mail (after retrieving it correctly earlier), try 
these steps in order until the problem goes away: 

1. Click Cancel, and then check your email again in a minute or two. 
Sometimes the problem goes away on its own. (If your account is 
offline, choose Mailbox > Take All Accounts Online.) 

2. Check and repair your keychain, following the instructions earlier in 
Keychain (Seemingly) Forgets Passwords. 

3. If the problem persists, return to Keychain Access. Locate your mail 
server in the list (for a MobileMe password, the entry will be your 
MobileMe user name), select it, and click Delete. The next time you 
check your email, you’ll be prompted for your password; enter it, 
select Remember This Password in My Keychain, and click OK. In 
most cases, the re-entered password should “stick” from then on. 

84
 



             
          

         

           
             

          

              
           

         

       

           
           

            
           

     

       

        
             

         
        

     
      

           
      

      
          

            
    

               
           
            

  

4. If even that doesn’t work, your mail server may be at fault. Try 
checking your messages with another email client. If the other client 
also gives you error messages, ask your ISP for help. 

Connection Errors 
Sometimes, when talking to a mail server, Mail encounters an error 
before it even gets to the point of sending your password. These errors 
tend to fall into two categories, which I call “squiggles” and “bangs.” 

If you see a symbol, which I call a “squiggle,” by an account name in 
your sidebar, that account is offline (not connected to the mail server.) 
The problem could also affect your computer as a whole. 

Listless: If you don’t see the individual account names in your 
sidebar, click the triangle next to the Inbox icon. 

You can take an account offline manually by choosing Mailbox > 
Online Status > Take “Account-Name” Offline; you can also take all 
your accounts offline at once by choosing Mailbox > Take All Accounts 
Offline. If Mail cannot connect to an account after multiple attempts, 
it takes the account offline automatically. 

If you encounter a squiggle, follow these steps: 

1.	 Check your Internet connection: Visit your favorite Web site 
to make sure your computer can access the Internet. If it cannot, the 
problem relates to a failed Internet connection (see You Lose Your 
Internet Connection). If it can, continue with the next step. 

2.	 Try bringing your accounts online manually: To reestablish 
a connection, click the symbol next to an account name. 
Sometimes this jogs the connection back to life. If the account 
remains offline, continue to the next step. 

3.	 Check mail server availability: Mail servers occasionally crash 
or become unreachable due to network problems. If an account 
remains offline even after you complete Step 2, contact your ISP to 
see if there’s a problem. 

If you see a symbol, which I call a “bang,” by an account name in 
your sidebar, that account had a failed connection. This means Mail 
could contact the server, but received an error message before it could 
log in. 
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If you encounter a bang, follow these steps: 

1.	 Try again: Click the bang symbol to see the error message Mail 
encountered. In the dialog that appears, click Take All Accounts 
Online. Sometimes errors are fleeting and go away if you do this. 

2.	 Check your authentication method: Mail can use any of 
several methods to send your mail server your user name and 
password. If you’ve chosen a method that your mail server doesn’t 
understand, it will complain. 

Choose Mail > Preferences, click Accounts, select your account, and 
click the Advanced button. At the bottom of the Advanced view set 
the Authentication pop-up menu to Password, close the Preferences 
window (saving changes when prompted), and try to connect again. 
If the error remains, repeat the procedure with the other options, 
starting with MD5 Challenge-Response. 

3.	 Verify your SSL setting: Another problem that can cause a bang 
is an incorrect SSL setting—some POP and IMAP servers support 
SSL, some don’t. 

To check your SSL setting, go to Mail’s Accounts preference pane, 
select your account, and click the Advanced button. Toggle the state 
of the Use SSL checkbox, close the Preferences window (saving 
changes when prompted), and try to connect again. 

In most cases, one of these changes will solve your problem. 

Fix Outgoing Mail (SMTP) Problems 
One of the most frequently reported problems with Mail is an inability 
to send messages—after clicking the Send button, an error message 
appears. Rather than go into every detail about the many possible 
causes, symptoms, and solutions, I want to focus on just two central 
points. If you get an error when sending mail, most likely the reason is 
one of the following: 

•	 You have incorrect SMTP settings. 

•	 The ISP running the network you’re currently connected to is 
blocking the port Mail wants to use. 

In both cases, the solution is usually to make sure you know the correct 
settings and then enter them in the proper places. 
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Find the Correct Settings 
When you initially set up your email account, your ISP or email 
provider should have provided you with a short list of information 
you need to access your account: 

•	 Your user name, password, and email address 

•	 Addresses for the incoming (POP, IMAP, MobileMe, or Exchange) 
mail server and the outgoing (SMTP) server 

•	 Whether the incoming and/or outgoing servers use SSL, which 
encrypts email in transit 

•	 You may also have received the following information: 

•	 What authentication method the servers use to verify your identity 
(for example, Password, MD5 Challenge-Response, or Kerberos) 

•	 What port(s) the incoming and outgoing servers can use 

You’ll need all this information now. If you can’t find it in your records 
or on your email provider’s Web site, contact their customer service 
department for assistance. 

Fix the “Incorrect Settings” Problem 
An SMTP server typically requires several settings to be correct: email 
address, user name, and password; the server’s address; the port; the 
authentication method; and the SSL setting (on or off). If any one of 
these is wrong, you won’t be able to send mail. Unfortunately, Mail’s 
error messages don’t always clarify which setting might be incorrect. 

If an error message doesn’t provide an obvious solution, do this: 

1. Choose Mail > Preferences, click Accounts, select your account in 
the list on the left, and go to the Account Information view. 

2. From the Outgoing Mail Server (SMTP) pop-up menu, choose Edit 
SMTP Server List. 

3. Confirm that the correct SMTP server is already selected in the list 
at the top; if not, select the one you want. 

4. In the Account Information view in the bottom portion of the 
dialog, confirm that the address in the Server Name field is exactly 
what your email provider specified (typically something like 
smtp.example.com). 
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5. In the Advanced view, confirm that the server port, Use Secure 
Sockets Layer (SSL) checkbox, authentication method, user name, 
and password exactly match what your email provider specified. 
If any of these items is incorrect, or if you’re not sure, change the 
information and click OK. Note that sometimes, email providers 
expect you to use your entire email address as the user name. 

Now, choose Window > Connection Doctor, and wait for it to complete 
its checks. Next to the SMTP server you just modified, if you see a 
green dot (on the left) and the text (on the right) “Connection and login 
to server succeeded,” the change worked. If not, proceed with: 

1. Return to the Advanced view from Step 5 just previously. Choose 
a different authentication method, click OK, and repeat the check 
in Connection Doctor. Repeat this step up to five times, trying each 
method (including None) in turn. If that doesn’t work… 

2. Back in the Advanced view, toggle the Use Secure Sockets Layer 
(SSL) checkbox, click OK, and repeat the check in Connection 
Doctor. 

3. If that doesn’t work, try the suggestions for fixing a blocked port, 
next. 

Fix the “Blocked Port” Problem 
Many ISPs routinely block the use of port 25, the “channel” most 
email programs use to send mail, except for email originating within 
that ISP’s network and sent via its own SMTP servers. For example, 
if you’re a Kabletown customer and connect via cable modem from 
your home, you could send email via Kabletown’s SMTP server 
through port 25. But you couldn’t send mail using, say, smtp.me.com 
on port 25 (because that server is outside the network from which 
you’re connecting); similarly, if you take your laptop to a coffee shop, 
whose network service is provided by another ISP, that network would 
likely block port 25, preventing you from reaching your regular 
Kabletown SMTP server while you’re away from home. 

Either way, the result is an error message when you try sending email 
from a particular account—even though you might be able to send 
from that account at another location, or from another account at your 
current location. 
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One way to solve this problem is to switch to a different port—one that 
isn’t blocked. For this to work, your email provider must support the 
use of the alternate port. To learn if they do, check their Web site or 
contact their technical support department…or just guess. The most 
commonly used alternative ports are 465 and 587, and Mail in Snow 
Leopard and later is smart enough to try these two ports automatically 
if port 25 doesn’t work. However, if your provider uses a less-common 
port (such as 2525) you can enter that manually. To do this: 

1. Choose Mail > Preferences, click Accounts, select your account in 
the list on the left, and go to the Account Information view. 

2. From the Outgoing Mail Server (SMTP) pop-up menu, choose Edit 
SMTP Server List. 

3. Confirm that the correct SMTP server is already selected in the list 
at the top; if not, select the one you want. 

4. In the Advanced view below, select Use Custom Port, enter the port 
number (whatever your ISP tells you) in the adjacent field, and click 
OK. 

Now, choose Window > Connection Doctor, and wait for it to complete 
its checks. Next to the SMTP server you just modified, if you see a 
green dot (on the left) and the text (on the right) “Connection and login 
to server succeeded,” all is well. If not, contact your ISP for assistance. 

If no alternative port solves the problem, you have three options: 

•	 Use your email provider’s webmail interface to send mail until you 
return to your regular network. 

•	 Send your email message from a different account in Mail, if one is 
available that doesn’t suffer from the port-blocking problem. 

•	 Use a virtual private network (VPN)—such as those provided at 
modest cost by PublicVPN (http://www.publicvpn.com/) or by 
WiTopia (http://witopia.net/), or the free Hotspot Shield service 
(http://www.hotspotshield.com/). 

A VPN makes it appear to remote servers as though your Mac is 
on a different network, not the one you’re actually connected to, 
and in most cases the VPN won’t block port 25. Once you connect 
your Mac to the Internet using one of these services, you should be 
able to send email on whichever port you normally use. 

89
 

http://www.publicvpn.com/
http://www.publicvpn.com/
http://witopia.net/
http://witopia.net/
http://www.hotspotshield.com/
http://www.hotspotshield.com/


  

          
            
           
             

            
          
           

           
           

        

        
              

            
              

   
           

           
               

             
           

           
    

             
            

            
             

             
            

            
  

Time Machine Misbehaves
 

Of the more than 100 Mac-compatible backup programs out there, 
Time Machine has the distinct advantage of being built into Mac OS X 
(and thus, both free and officially supported by Apple). For reasons I 
detail in my books about backups, I think Time Machine alone is an 
insufficient backup solution, but it’s pretty good as far as it goes. 
However, because you’re entrusting your valuable data to your backup 
software, it can be especially scary and frustrating when that software 
flakes out—as Time Machine has been known to do. Worse, Time 
Machine tends to be pretty opaque; finding out exactly what’s gone 
wrong or how to fix it can be tricky. 

The ways in which Time Machine sometimes misbehaves are 
numerous, and I can’t cover them all here. But I do want to mention 
a few of the most common concerns and how to deal with them—as 
well as point you to some places where you can learn more about other 
sorts of errors. 

Discover a Time Machine Problem 
One of the strangest things about Time Machine misbehavior is that 
it’s often silent—that is, some kinds of failure happen almost invisibly, 
and unless you know where to look and what to look for, you might not 
know that backups have been failing for days on end. Backups are so 
important that I’d prefer to see a prominent alert whenever anything 
goes wrong, but Time Machine presents such alerts only in what it 
deems to be exceptional circumstances. 

Usually, what you see is more subtle: the Time Machine menu bar icon 
(assuming you have it showing) changes in one of two ways to display 
an exclamation point in the center. If the backup destination disk was 
unavailable the last time Time Machine tried to run, the icon has a 
simple exclamation point in it; if the last backup was not merely 
delayed due to unavailable media but failed for some other reason, the 
icon changes to show an exclamation point inside a triangle (the 
standard “alert” symbol).
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Heads up: Because the Time Machine icon in the menu bar is 
sometimes the only clue that Time Machine is having problems, I 
recommend making sure it’s visible. If it’s not, open the Time Machine 
pane of System Preferences and select the Show Time Machine Status 
in the Menu Bar checkbox. 

In either of these cases, you can click the Time Machine menu and 
then choose the first command (either Latest Backup: Delayed or 
Latest Backup: Failed) to open the Time Machine pane of System 
Preferences and display a dialog with explanatory text. (Alternatively, 
you can open the Time Machine preference pane manually. Next to the 
text “Latest Backup” will be the word “Failed” or “Delayed” in red, next 
to a red “i” icon. Click that icon to display the same explanatory text 
(and then refer to later portions of this section to find out what to do). 

You may also notice that the regular Time Machine menu bar icon
 
(with the clock hands spinning backward as the backup progresses) 
simply takes an unusually long time. In this case, once again, click the 
menu; the first item on it tells you what Time Machine is currently up 
to. If it says something like “Calculating Changes” or “Preparing” for 
more than a few minutes, let it run its course, even if that takes hours. 
Time Machine has determined that it must double-check every single 
file on your disk for some reason, and if you interrupt the process, it’ll 
simply start all over again later. 

If the menu says something else that you can’t understand, launch 
Console (see Check Log Files), choose File > Open System Log, and 
type backupd into the Filter field to view only the entries involving Time 
Machine. What you find could give you some idea of the problem. 

Help Time Machine Find an Unavailable Disk 
If the Time Machine’s error message tells you that the backup disk 
is not available (wording may vary slightly), this isn’t necessarily a 
problem—for example, if you’ve intentionally disconnected the backup 
disk for some reason, it’s entirely expected. However, if you didn’t 
deliberately disconnect the backup disk, try the following: 

•	 If your backup disk is connected locally (via USB or FireWire, for 
example), check to see that the disk appears in the Finder (either 
on the Desktop or in the sidebar of a Finder window). If it does, 
eject it by dragging it to the Trash icon or selecting it and pressing 
Command-E. Then, either way, physically unplug the drive. If the 
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drive uses an external AC adapter, make sure it’s plugged in on both 
ends, and that the light is on (indicating it’s receiving power). Then 
reattach the drive to your Mac. 

•	 If your backup disk is a Time Capsule (or an external disk connected 
to the Time Capsule), restart the Time Capsule using AirPort Utility 
(in /Applications/Utilities). 

•	 If your backup disk is another network volume, check to see that 
the volume appears in the Finder. If it does, eject it. Then, either 
way, reconnect to the network volume in the Finder. 

After doing any of these things, return to the Time Machine pane 
of System Preferences, click Select Disk (or Choose Disk) and verify 
that the correct volume is selected; if it isn’t, select it and click Use 
for Backup. Then choose Back Up Now from the Time Machine menu. 

Fix a Damaged Backup Disk 
If the backup volume (either the physical disk itself or, in the case 
of network backups, the disk image on the disk) becomes damaged 
or corrupted, it can lead to a variety of error messages, such as an 
inability to copy a certain file or create a folder, a claim that the disk is 
read-only, or a failure to restore a file. Sometimes you can repair such 
errors with Disk Utility and then continue your Time Machine backups 
normally, although in my experience, Disk Utility is often unsuccessful. 
But it never hurts to try. Do this: 

1. Open the Time Machine pane of System Preferences and turn Time 
Machine off. 

2. If you use a Time Capsule or other network volume, connect using 
an Ethernet cable if you can, because it will make the repair go 
much faster. 

3. Make sure your Time Machine backup disk is connected and 
mounted in the Finder. (For Time Capsules or network volumes, 
select the device in a Finder window’s sidebar. If it doesn’t mount 
automatically, click Connect As and supply your credentials if 
prompted.) 

4. Open Disk Utility (in /Applications/Utilities). 
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5. Select your Time Machine volume: 

‣	 For directly attached hard drives, select the Time Machine 
volume (indented underneath the disk name) in the sidebar. 

‣	 For internal Time Capsule disks or network volumes, navigate in 
the Finder to the folder containing your backups (usually there’s 
only one, at the top level of the volume, but the name varies), and 
drag the disk image file corresponding to the name of your 
computer into Disk Utility. Then select that disk image in Disk 
Utility’s sidebar. 

‣	 For external disks connected to a Time Capsule, navigate in the 
Finder to the folder containing your backups and double-click 
the disk image file corresponding to the name of your computer. 
Then select that disk image in Disk Utility’s sidebar. 

6. Click Repair Disk. 

Wait for the repair process to complete—and note that it could take 
a long time. If it succeeds, you should be back in business; turn Time 
Machine back on and it should run normally. If it fails, you’re most 
likely out of luck—you’ll have to erase your backup disk and start over 
from scratch. 

Solve Other Time Machine Problems 
If your difficulties with Time Machine go beyond what I’ve mentioned 
here, consult these resources: 

•	 Apple’s official support page on troubleshooting Time Machine is 
at http://web.me.com/pondini/Time_Machine/. 

•	 James Pond has an excellent and extensive Web site about Time 
Machine at http://web.me.com/pondini/Time_Machine/, 
including a thorough troubleshooting section at http:// 
web.me.com/pondini/Time_Machine/Troubleshooting.html. 

•	 If your problem with Time Machine is that it’s bogging down your 
Mac when it runs, see my book Take Control of Speeding Up Your 
Mac for suggestions. 
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A Volume Won’t Unmount
 

Have you ever tried to eject a CD, disk image, or network volume, 
only to see an error message saying the volume is in use? If so, the 
maddening part can be figuring out which process is using it so you 
can quit that process. To find the offending process, open Terminal 
(in Applications/Utilities) and enter the following, substituting for 
VolumeName the name of the volume you can’t unmount: 

sudo lsof | grep /Volumes/VolumeName 

Enter your administrator’s password when prompted. This command 
shows any processes that are currently using this volume. For example: 

Installer 8907 jk txt REG 14,6 348480 369666 /Volumes/MyApp/ 
Install MyApp.app/Contents/MacOS/installer 

You’re interested in the first two items in the line—the name of the 
process (Installer in this example) and the process ID, or PID (8907 in 
this example)—that’s the process that’s using something on the volume 
you want to eject. Armed with this information, you can quit the 
program—either by switching to it in the Finder and using the Quit 
command, or by using the kill command in Terminal. First try this 
command (with the process’s PID filled in where PID is): 

kill PID 

And if that doesn’t work, try this more-powerful variation: 

kill -9 PID 

One frequent offender: the bash shell (Mac OS X’s default command-
line environment) itself! In that case, you’ll see something like this: 

bash 14384 jk cwd DIR 45,8 330 2 /Volumes/Data 

If you’ve navigated to a directory on this volume in your shell, Mac 
OS X considers it “in use.” The easiest solution in this case is to close 
the Terminal window. 

Note: This tip is adapted from my book Take Control of the Mac 
Command Line with Terminal, which also has many more such 
“recipes.” 
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Troubleshoot 
Novel Problems 
Sooner or later, you’re bound to encounter some problem you 
haven’t experienced before, and which the previous chapter doesn’t 
cover. Although I’ve seen hundreds of different things go wrong 
with Macs over the years, I still run across novel problems all the 
time. If the solution to some problem isn’t immediately obvious, I 
go through a series of steps to narrow down the possible causes and 
test remedies until I find one that works. That’s what I want to teach 
you to do here. 

First, I ask you to try some easy all-purpose solutions. But at a 
certain point, you may need to look further for help. I describe how 
to get more information and troubleshooting advice from a number 
of different sources. 

Try the Standard Quick Fixes
 

If I get a headache, I generally take a couple of over-the-counter 
pain relievers. If the headache goes away, I don’t worry about the 
cause; I just get on with my day. Only if it doesn’t go away, or recurs, 
or accompanies other symptoms, will I call my doctor. Lots of Mac 
problems fall into the same category. You can try any or all of several 
all-purpose procedures that tend to zap lots of common irritations. 
If the problem goes away, there’s no need to waste time tracking down 
its exact cause, but if the quick fixes don’t work or the problem comes 
back, you can move on to more detailed troubleshooting (see Ask the 
Right Questions, a few pages ahead). 

Quick Fixes for Application Misbehavior 
One of the most frequent Mac problems is an application that fails to 
launch, refuses to open a certain document, has display problems, or 
otherwise starts behaving erratically. 
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If this happens to you, try each of these procedures in turn until the 
problem disappears: 

1.	 Quit and try again: If a program isn’t cooperating in any way, 
quit it, reopen it, and then test to see if the problem is still there. 

2.	 Force-quit the application: If the problem remains, or if the 
application won’t quit normally, force-quit it and open it again 
(see Force-Quit an Application). If it doesn’t work the first time, 
it’s worth trying this procedure a few times in a row. 

3.	 Restart: As always, restarting is a good way to zap numerous odd 
problems. Flip back to Restart Your Mac. 

4.	 Remove the preference file: If the application still misbehaves 
after restarting, follow the procedure for checking or disabling its 
preference file (read Check Preference Files) and launch it again. 

5.	 Repair disk permissions: Although rare, it can happen that 
incorrect file permissions prevent an application—particularly one 
from Apple—from working correctly. See Repair Permissions. 

6.	 Clear your caches: Focus on the cache for the application that’s 
misbehaving. Try Clear Caches. 

If none of these ideas leads to a solution, skip ahead to Ask the Right 
Questions, next page. 

Quick Fixes for System-Wide Problems 
Sometimes it’s not just a single application that’s misbehaving. If 
your whole system appears to be slow or unresponsive, or otherwise 
behaves in an unexpected way, try these fixes: 

1.	 Close extra windows, tabs, or applications: Sometimes 
applications can chew up RAM and CPU cycles even if they’re 
running in the background and seemingly doing nothing. Having 
many open tabs or windows (even in the Finder) can also increase 
your RAM usage. Try quitting applications or closing tabs or 
windows you’re not actively using. 

2.	 Restart: You know the drill—if not, read Restart Your Mac. 

3.	 Check for free space: Be sure your disk isn’t close to being full. 
Free up at least a few gigabytes. See Check Free Disk Space. 
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4.	 Unplug peripherals: Hardware devices can sometimes cause odd 
problems, as can the driver software that communicates with them. 
Unplug any nonessential devices and see if the problem goes away. 

5.	 Repair disk permissions: If you’ve recently installed or updated 
any software, it’s possible that the installer munged some essential 
preference settings. See Repair Permissions. 

6.	 Run a disk-repair utility: At the very least, use Disk Utility’s 
Repair Disk feature, which has been known to solve some weird 
random problems. Read more in Run Disk-Repair Utilities. 

7.	 Clear your caches: Focus on system-wide caches (those found 
in /Library/Caches). Turn back to Clear Caches for details. 

8.	 Disable unneeded doohickeys: System enhancements that 
run in the background (including menu extras and some preference 
panes) can sometimes cause problems with your Mac. Follow the 
developer’s instructions for disabling or removing them, restart, 
and see if the condition persists. 

9.	 Try your backup: If you have a bootable duplicate, start up 
your Mac from your backup volume (instructions are in Start Up 
from Another Volume). 

If the problem goes away, you know that something has changed 
since that backup occurred. One easy solution at this point is to 
reverse the backup—duplicate your backup volume back onto your 
regular startup volume. But in so doing, unless you’re very careful, 
you’ll lose any changes made to your startup volume since your 
last backup. If possible, therefore, make a second duplicate of 
your startup volume—or at the very least make a backup your 
home folder, which contains the files most likely to have changed— 
so you can recover them after reversing your duplicate. 

14. Reinstall Mac OS X: Although it sounds unpleasant, it’s not that 
bad—and it can solve a lot of difficult problems that nothing else 
can. For instructions, flip back to the sidebar A Clean Start. 
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Ask the Right Questions
 

If pain relievers haven’t cured my headache, I’d call my doctor, and 
she’d probably ask me a series of predictable questions, such as these: 
Have you hit your head recently? Have you had headaches like this 
before? Do you have any history of brain injuries or disease? Do you 
have any other symptoms, such as blurry vision or dizziness? The point 
of such questions is to identify the most likely (or most serious) causes 
first. 

When your Mac has a problem that doesn’t respond to the easy cures, 
begin by asking yourself these questions: 

•	 Has anything changed recently? For example, if the problem 
started shortly after updating Mac OS X or installing new software, 
that suggests a possible culprit. 

Update Got You Down? 

If you experience problems after installing an update to Mac OS X— 
particularly if you used Software Update—try reinstalling the update 
another way. Apple releases most updates in two forms: 

✦ A standard (or “delta”) form that works only with the previous 
version of Mac OS X (updating, say, Mac OS X 10.6.6 to 10.6.7) 

✦ A “combo” form that works with several previous versions (say, 
anything from 10.6.0 through 10.6.6) 

Software Update always chooses the smallest possible updater, 
which usually means the delta updater. Occasionally, however, delta 
updaters leave out files that are included in the combo updater. So 
when in doubt, download the combo updater manually from http:// 
www.apple.com/support/downloads/ and run it again. (You won’t 
harm anything by running an updater again.) 

•	 What did you do last? If an application crashed immediately 
after you performed some action, what was that action? Recurring 
patterns are especially important. If a problem occurs every time 
you do something, that something becomes suspicious. 

•	 Did you see any error messages? I can’t tell you how many 
times someone has complained to me about a Mac problem, and 
then mentioned casually, “Oh yeah, there was some sort of error 
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message, but I didn’t pay attention to it.” An error message is 
one of the best possible clues to a problem’s cause and solution, 
so you should make a note of it. The easiest way to do this is to 
take a screenshot. Press Command-Shift-3 and Mac OS X takes 
a picture of your whole screen, saving it to a file on your Desktop. 

You can then refer to that picture, email it to a technical support 
person, or print it out if needed. (If your Mac is frozen and the 
screen shot procedure doesn’t work, at least write down the error 
message!) By the way, even if no error messages appeared on 
screen, one might have been written to a log file. Be sure to take 
a look (see Check Log Files). 

•	 What does the Help say? Amazing but true: applications’ 
online help (or other included documentation) sometimes actually 
provides useful information. Yet users overlook this valuable 
resource shockingly often. Check out the commands in the 
application’s Help menu or read the help files that came with it. 

•	 Is anything else wrong with your Mac? If your computer 
is crashing frequently, and it’s also making a buzzing sound and 
billowing smoke, chances are those three symptoms are connected 
to each other. Even less serious symptoms, such as unexpected 
slowdowns, can be significant. 

•	 Is the problem reproducible? Follow the suggestions in Test 
for Reproducibility. See if you can find a series of steps that always 
causes the problem you’re seeing, or a series of steps that always 
avoids the problem. If you can, you’re halfway to a solution. 

All right, you’ve asked the right questions and have some answers— 
but what do you do with that information? In some cases the answers 
may be obvious. For example, you realize that a problem occurred right 
after installing some software, so you uninstall the software, and the 
problem goes away. 

But in most cases, it’s time to dig deeper. Look for, and test, 
procedures suggested by the vendor, a troubleshooting Web site, 
or another resource. Repeat until the problem goes away—or until 
you’ve exhausted all your ideas and it’s time to call a consultant 
or repairperson. 
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Who ya gonna call? The remainder of this chapter lists resources 
you can consult to help you solve your problem, but don’t forget about 
your friendly neighborhood Mac geek (see Phone a Friend and Ask at 
a User Group). If you happen to have a Mac expert in your quick-dial 
list, now’s the time to call. 

Ask the Vendor for Help
 

When it’s clear that a particular piece of hardware or software is 
malfunctioning and none of the easy troubleshooting steps helped, 
your next step should be to contact that product’s developer. Although 
I use the term “vendor” as a generic way to denote a software developer 
or a hardware manufacturer, I want to clarify that I’m not talking 
about the store where you purchased something. Go right to the 
company or individual who made it. 

Apple Products 
If Apple made the product, begin by visiting http://www.apple.com/ 
support/. There you can find technical articles, discussion forums, and 
links to download software updates. 

Searching 
If you’re unsure where to look for help, type some text into the search 
field and press Return. Start by entering your Mac model and a few 
words describing the problem (such as MacBook Pro fan noise or iMac 
G5 shuts down). If that yields too few results, make your search broader 
—for example, by omitting the model name, since a symptom may 
apply to many models. If you get too many matches, try narrowing 
your search—for example, by including your Mac OS X version number 
(MacBook Pro fan noise 10.5.6). 

The search results page may have several pop-up menus at the top 
that allow you to optionally narrow your search further. Of these, two 
are particularly interesting: In the Restrict by Product pop-up menu, 
choose the hardware or software that’s having problems (if you’re 
sure what it is, and if it appears in the list). And, from the Restrict by 
Document Type pop-up menu, choose one of the following categories: 

• All Solutions: combines the results from all the categories 
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•	 Discussions: posts in Apple’s Support Communities (described 
just ahead) 

•	 Downloads: software and firmware updates that may apply to 
your problem 

•	 How To: step-by-step procedures for performing common tasks, 
including solving some problems 

•	 Manuals: PDF versions of user manuals for Apple products 

•	 Site Help: help using the Apple support site itself 

•	 Specification: characteristics of devices matching your search 

•	 Troubleshooting: articles Apple has written with descriptions 
of (and usually solutions for) particular issues 

Apple Support Communities 
Apple provides discussion forums called Apple Support Communities 
where users can help each other with their Macintosh problems. You 
can find the forums at http://discussions.apple.com/. 

On this site, you can click a category (Apple calls them “communities” 
now, but each one is essentially a discussion forum that revolves 
around a particular product) to browse a subject area or use the search 
field to search all discussions. Generally, I suggest clicking a category 
first, and then click the Refine This List link under “Recent Content” to 
narrow the list of matches. If neither searching nor browsing produces 
close matches for your problem, type your question in the large field 
on the Overview tab, click Submit My Question to the Community, and 
log in with your Apple ID (if you haven’t already done so). 

I’ve found lots of useful information in the Apple Support 
Communities site, but I want to emphasize two things. First, Apple 
monitors the discussions but does not directly reply to any posts, so 
don’t assume that you’ll get help from Apple. Second, to inform Apple 
of something behaving incorrectly, you must use a different site, which 
is available only to registered Apple Developers. (You can register for 
free at http://developer.apple.com/programs/register/.) The Apple 
Bug Reporter site is at https://bugreport.apple.com/. Apple will see all 
bug reports, but will respond only if additional information is needed. 
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Downloads 
Your problem might be solved by updating your Apple software, 
although the Software Update application is usually a better way of 
finding and installing the updates appropriate to your system. To look 
for updates, go to http://support.apple.com/downloads/. Like the 
other pages on Apple’s support site, the Downloads page has its own 
search box, as well as a list of recently posted updates. If the software 
you’re looking for isn’t on the first page of the list, use the search box. 

Live Help 
If online help didn’t supply the answer, you have a few more options: 

•	 If you’re in the United States or Canada, try Apple’s Express Lane 
service at https://expresslane.apple.com/. This site walks you 
through a brief series of questions to narrow down your problem 
to possible solutions. If none of them does the trick, you can fill out 
a form with details about your problem and request that Apple call 
you immediately, or at a scheduled time in the future. (Note that for 
most issues, Apple requires you to enter your Mac’s serial number.) 

•	 Take your Mac to a Genius Bar (see Go to the Source). 

•	 Contact Apple Support. In the United States, you can call them toll-
free at 800-275-2273; in Canada, the number is 800-263-3394. 

•	 For other countries, or for online support options, see http:// 
www.apple.com/support/contact/. 

These services are free if your Apple product is still under warranty 
(or AppleCare), but if your Apple product is no longer covered, you 
can pay for a tech support “incident” ($49); ask for details when you 
contact Apple. 

Other Products 
For third-party products, start by visiting the vendor’s Web site. To 
read FAQs, download software updates, ask questions of other users 
on discussion forums, and find out how to contact their support staff 
by phone or email, look for a link or button that says “Support” or 
“Technical Support.” Be aware that some vendors charge a fee for 
technical support, or offer complimentary support only for a limited 
time. If you’re unable to find contact information, check the packaging 
the product came in or its printed documentation. 
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When you contact the vendor, be prepared to explain in detail the 
nature of your problem, what steps you’ve taken to solve it, and any 
background information (as covered in Ask the Right Questions) that 
might provide clues. Also be sure you know the exact Mac model you’re 
using, including processor type and amount of RAM, as well as which 
version of Mac OS X (and the vendor’s software, if any) you’re running. 
If you’re unsure, see Get System Information. 

Check Mac Troubleshooting Sites
 

If haven’t found the solutions you need in this book, at a vendor’s 
Web site, or on Apple’s Web site, you can avail yourself of numerous 
other sites that contain a vast store of information about solving Mac 
problems. These sites often include discussion forums where other 
people with similar issues can share what they tried and what worked 
for them. Among the many Mac troubleshooting sites out there, these 
are the ones I’ve typically found most useful (listed alphabetically): 

•	 CNET Reviews’ MacFixIt (http://reviews.cnet.com/macfixit/): 
MacFixIt has been around for many years, although the ownership 
of the site and its fundamental character have changed more than 
once. Regardless, it has an astonishing amount of information 
available. Of particular interest are the tutorials on solving common 
problems (choose Tutorials from the Archives pop-up menu) and 
the discussion forums (click the Forums button). 

Getting your fix: I like MacFixIt and visit it regularly. But I 
want to warn you that I consider many of their recommendations 
overcautious—they frequently suggest procedures that, in my 
opinion, require an excessive investment of time and effort for 
questionable gain. Also, because the site mentions almost every 
odd problem anyone has discovered, it might make you paranoid 
that no software update is safe to install, when, in fact, almost no 
one may have experienced that particular problem. So: do seek 
help at MacFixIt when you need it, but be prepared to take some 
of their suggestions with a grain of salt. 

•	 MacInTouch (http://www.macintouch.com/): This site provides 
Apple-related news and, of interest to people looking for 
troubleshooting help, an ongoing series of reader reports on many 
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Mac hardware and software products. If you’re having trouble with 
a system update, a new computer, or a peripheral, scanning these 
reports can give you valuable clues. But remember: the fact that 
someone reports a problem doesn’t mean you or anyone else will 
encounter it, and not every proposed solution will work for you. 

•	 MacOSX.com (http://macosx.com/): This free Mac tech support 
site provides personalized help from a team of volunteers. You can 
also post questions on a public forum and search the results of past 
troubleshooting queries. 

•	 Mac OS X Hints (http://www.macosxhints.com/): Mac OS X 
Hints is now part of Macworld. Its focus is not on troubleshooting 
but on getting more out of your Mac generally; it just so happens 
that many of the tips provide the solutions to common problems. 

•	 Trouble-Shooting Language Problems (http:// 
homepage.mac.com/thgewecke/mlingos9.html#trouble): If your 
problem involves foreign languages in any way, you may find the 
solution in this helpful list by the estimable Tom Gewecke, who 
has contributed many useful bits of information about Mac OS X’s 
language handling to various Take Control titles. 

•	 The X Lab (http://www.thexlab.com/): This site has numerous 
useful FAQs on solving problems with Mac OS X. It also promotes 
a gargantuan (over 600-page) ebook called Troubleshooting Mac 
OS X, written by “Dr. Smoke” (Gregory E. Swain). 

Use Your Favorite Search Engine
 

If you haven’t found what you’re looking for on any of the top Mac 
troubleshooting sites, you may still have success elsewhere on the 
Web. Try some searches in Google (or the search engine of your 
choice). When you do, keep in mind these tips: 

•	 To narrow searches, be as specific as possible. For example, 
searching for GarageBand crash will produce fewer and far more 
relevant results than application quits. 

•	 Try including the word Mac or the phrase "OS X" (in quotation 
marks) in your search to exclude some matches that are specific 
to Windows or Unix software. 

104
 

http://macosx.com/
http://macosx.com/
http://www.macosxhints.com/
http://www.macosxhints.com/
http://homepage.mac.com/thgewecke/mlingos9.html#trouble
http://homepage.mac.com/thgewecke/mlingos9.html#trouble
http://homepage.mac.com/thgewecke/mlingos9.html#trouble
http://homepage.mac.com/thgewecke/mlingos9.html#trouble
http://www.thexlab.com/
http://www.thexlab.com/
http:MacOSX.com


          
         

  

               
    

 

          
          

               
            

         

           
            

         
            

           

•	 Include the version number in your search. For example, searching 
for kernel panic Mac 10.5.6 might show you more recent and useful 
results than kernel panic Mac. 

•	 If you saw an error message on screen or in a log, try searching for 
the text of that message. 

Contact a Professional
 

I’ve mentioned this several times already, but it’s worth repeating: lots 
of smart, experienced people make their livings solving Mac problems, 
and you can contact one if you get stuck. Yes, you’ll have to pay some 
money, but if your problem is more than trivial you’ll probably find 
that the savings in time (not to mention stress) is worth it. 

Assuming you’ve gone through the steps in this chapter more or less 
in order, you should think about visiting a consultant (flip back to 
Find a Consultant) or an Apple repair facility (described in Go to 
the Source), keeping in mind that only the latter can offer low-level 
hardware repairs on your Mac or provide service under warranty or 
AppleCare. 
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Learn More
 
Besides the Web sites listed in Check Mac Troubleshooting Sites, 
a few other resources may be of interest. 

Ebooks
 

•	 Macworld Mac Troubleshooting Superguide 

•	 Take Control of Font Problems in Leopard, by Sharon Zardetto 

•	 Take Control of Maintaining Your Mac, by Joe Kissell 

•	 Take Control of Speeding Up Your Mac, by Joe Kissell 

•	 Troubleshooting Mac OS X by “Dr. Smoke” (Gregory E. Swain) 
is a 600-page ebook that goes into great detail about solving a 
wide variety of Mac problems. http://www.thexlab.com/book/ 
troubleshootingmacosx.html ($19.95) 

Printed Books
 

•	 Apple Training Series: Mac OS X Support Essentials v10.6 by 
Kevin M. White. Heavy-duty support information targeted at Mac 
consultants and technicians. http://www.amazon.com/gp/product/ 
0321635345/ ($64.99 retail; current Amazon.com price, $46.42) 

•	 Macs Portable Genius by Paul McFedries. Includes details about 
using, configuring, maintaining, and troubleshooting your Mac. 
http://www.amazon.com/gp/product/0470874023/($25 retail; 
current Amazon.com price, $16.50) 

•	 Mac Secrets by Mark Hattersley. Another general-purpose book 
of Mac tips and tricks, including troubleshooting help. http:// 
www.amazon.com/gp/product/0470637889/ ($49.99 retail; 
current Amazon.com price, $31.49) 
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About This Book
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. 

Ebook Extras
 

You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 

About the Author
 

Joe Kissell is Senior Editor of TidBITS and the author of numerous 
books about Macintosh software, including Take Control of Mac OS X 
Backups and Take Control of Maintaining Your Mac. He is also a 
Senior Contributor to Macworld, was the winner of a 2009 Neal award 
for Best How-to Article, and has appeared on the MacTech 25 list 
since 2007. Joe has worked in the software industry since the early 
1990s, and he previously managed software development for Nisus 
Software and Kensington Technology Group. He lives in Paris with his 
wife, Morgen Jahnke, their son, Soren, and their cat, Zora. 

To contact Joe about this book, send him email at jwk@me.com and 
include Take Control of Troubleshooting Your Mac in the subject so 
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his spam filters won’t intercept it. Better yet, if appropriate, post your 
question at http://www.getsatisfaction.com/takecontrolbooks/. 

Shameless Plug
 

Although I write about computers as my day job, I have a great many 
other interests, which I write about on several Web sites, including 
Interesting Thing of the Day and my personal blog. You can find links 
to all my sites, a complete list of my publications, and more about me 
at JoeKissell.com. You can also follow me on Twitter (@joekissell). 

About the Publisher
 

Publishers Adam and Tonya Engst have been creating Apple-related 
content since they started the online newsletter TidBITS, in 1990. 
In TidBITS, you can find the latest Apple news, plus read reviews, 
opinions, and more (http://www.tidbits.com/). Adam and Tonya are 
known in the Apple world as writers, editors, and speakers. They are 
also parents to Tristan, who thinks ebooks about clipper ships and 
castles would be cool. 

Production credits: 

• Take Control logo: Jeff Tolbert 

• Cover design: Jon Hersh 

• Editor, Publisher: Adam Engst 

• Editor in Chief: Tonya Engst 

• Production Assistant: Michael E. Cohen 
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Copyright and Fine Print
 
Take Control of Troubleshooting Your Mac, Second Edition 

ISBN: 978-1-61542-136-7
 
Copyright © 2011, Joe Kissell. All rights reserved.
 

TidBITS Publishing Inc.
 
50 Hickory Road
 

Ithaca, NY 14850 USA
 
http://www.takecontrolbooks.com/
 

Take Control electronic books help readers regain a measure of control in an oftentimes 
out-of-control universe. Take Control ebooks also streamline the publication process so 
that information about quickly changing technical topics can be published while it’s still 
relevant and accurate. 

This electronic book doesn’t use copy protection because copy protection makes life 
harder for everyone. So we ask a favor of our readers. If you want to share your copy of 
this ebook with a friend, please do so as you would a physical book, meaning that if your 
friend uses it regularly, he or she should buy a copy. Your support makes it possible for 
future Take Control ebooks to hit the Internet long before you’d find the same information 
in a printed book. Plus, if you buy the ebook, you’re entitled to any free updates that 
become available. 

Although the author and TidBITS Publishing Inc. have made a reasonable effort to ensure 
the accuracy of the information herein, they assume no responsibility for errors or 
omissions. The information in this ebook is distributed “As Is,” without warranty of any 
kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person or entity 
for any special, indirect, incidental, or consequential damages, including without 
limitation lost revenues or lost profits, that may result (or that are alleged to result) from 
the use of these materials. In other words, use this information at your own risk. 

Many of the designations used to distinguish products and services are claimed as 
trademarks or service marks. Any trademarks, service marks, product names, or named 
features that appear in this title are assumed to be the property of their respective owners. 
All product names and services are used in an editorial fashion only, with no intention of 
infringement of the trademark. No such use, or the use of any trade name, is meant to 
convey endorsement or other affiliation with this title. 

This title is an independent publication and has not been authorized, sponsored, or 
otherwise approved by Apple Inc. Because of the nature of this title, it uses terms that are 
the trademarks or the registered trademarks of Apple Inc.; to view a complete list of the 
trademarks and of the registered trademarks of Apple Inc., you can visit http:// 
www.apple.com/legal/trademark/appletmlist.html. 
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Featured Titles
 
Click any book title below or visit our Web catalog to add more 
ebooks to your Take Control collection! 

Take Control of Apple Mail in Snow Leopard (Joe Kissell): Go under 
the hood with the new (and old) features in Apple Mail 4. Joe gets you 
going and helps you get the most out of Mail. 

Take Control of Font Problems in Leopard (Sharon Zardetto): If you’re 
suffering from mysterious font problems in Leopard, help is at hand! 

Take Control of Fonts in Snow Leopard (Sharon Zardetto): Install, 
organize, and use fonts with ease in Mac OS X 10.6 Snow Leopard (and 
10.5 Leopard)! 

Take Control of the Mac Command Line with Terminal (Joe Kissell): 
Learn the basics of the Unix command line that underlies Mac OS X, 
and get comfortable and confident when working in Terminal. 

Take Control of Mac OS X Backups (Joe Kissell): Set up a rock-solid 
backup strategy so that you can restore quickly and completely, no 
matter what catastrophe arises. 

Take Control of Maintaining Your Mac (Joe Kissell): Discover a 
commonsense approach to avoiding problems and ensuring that your 
Mac runs at peak performance. 

Take Control of Permissions in Snow Leopard (Brian Tanaka): Solve 
quirky problems, increase privacy, and share files better. 

Take Control of Speeding Up Your Mac (Joe Kissell): Put the zip 
back into your Mac with advice based on Joe’s extensive research and 
experimentation in the area of Mac performance. 

Take Control of Upgrading to Lion (Joe Kissell): Find friendly advice 
that prepares you for a successful installation, plus learn how to best 
run the installer while avoiding problems. 

Take Control of Users & Accounts in Snow Leopard (Kirk McElhearn): 
Find straightforward explanations of how to create, manage, and work 
with—and among—user accounts. 
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